
Free Agent Contents
Free Agent is a powerful and easy-to-use Usenet newsgroup reader.    It allows you to browse 
newsgroups both online and offline.    Before you start using Free Agent, please take a quick look at 
Getting Started.

For more information about using Free Agent, see How to Use Agent.

For full email support, a spell checker, and more advanced newsreading features, try Forté’s commercial 
package, Agent.    See Agent Features for a more detailed description of this product.    To purchase your 
own copy of Agent, see Ordering Agent.

If you have any comments, questions, or problems with Free Agent, see How to Receive Technical 
Support.

To help familiarize yourself with Free Agent’s Newsgroup window, click on the various components of the 
picture below.
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How to Use Agent
Before you start using Agent, please take a quick look at Getting Started.

Once you’re up and running, check out the topics below for more help using Agent.

How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader

How to Post Articles
How to Send Email
Making Sure Articles and Emails Were Sent Properly

How to Send a Binary Attachment
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent

Online Menu Commands Explained

About Article Purging
Compacting Agent’s Database Files
Marking Articles Read

Navigating in Agent
Watching and Ignoring Threads
Message Text Display Options

ROT13 Encoding and Decoding
Copying a WWW URL to the Clipboard
How to Get All the Article Bodies in a Group
How Agent Knows Which Articles are New
Printing Articles
Finding Groups or Articles

Frequently Asked Questions



Frequently Asked Questions
This topic answers some of the most common questions users have about Agent.

How to configure Agent for multiple users
Agent forgets settings or loses all its data
Pressing (M)ark or (I)gnore causes Agent to jump around
Errors reported by the news server
Errors reported by Winsock
Pressing any buttons while offline causes Agent to hang
Headers/Articles are marked as read after performing an online task
How to re-send a failed post or email
Agent failed to decode a binary file
Expand Threads doesn't always work
How to restore a deleted group



How to configure Agent for multiple users
Agent stores its settings and data files in the working directory specified by its Program Manager icon.    
This allows you to easily share a single copy of the program’s executable files (i.e., agent.exe and 
agent.hlp) among several users.

To setup Agent for multiple users:
1. Create a directory for the program files (e.g., c:\agent).

2. Create a personal directory for each user (e.g., c:\agent\his and c:\agent\hers).

3. Create a Program Manager icon for each user with the Command Line pointing to the program itself 
(e.g., c:\agent\agent.exe) and the Working Directory pointing to the user’s personal directory 
(e.g., c:\agent\his and c:\agent\hers).



Agent    forgets settings or loses all its data
Agent expects to find its setting and data files in the directory in which it runs.    If it can't find them, it 
assumes it is being run for the first time and displays the license screen. It will also “forget” any 
preferences, properties, and subscribed groups you have saved.

To correct this problem, select (single click) the Agent icon on your Program Manager desktop.    On the 
Program Manager menu, select Properties from the File menu.    You will be presented with the Program 
Item Properties dialog box.    Make sure the Working Directory is set to the directory that Agent stored its 
data files (usually the same directory where Agent is installed).

If you run Agent from a program that doesn’t allow you specify the working directory, you can pass this 
information to Agent on its command line.    For example, the command to run Agent may look like this:

c:\agent\agent.exe c:\agent



Pressing (M)ark or (I)gnore causes Agent to jump around
Agent automatically skips to the next unread article when you mark an article for retrieval or ignore a 
thread. If you don’t like this behavior, you can disable it from the Navigation tab of the Preferences dialog 
box by unchecking the “Marking or ignoring an article skips to the next unread article” box.



Errors reported by the news server
This topic will help you track down errors reported by your news server and detected by Agent.

441 400 Bad file number Writing history file - Throttling
441 400 loadav [innwatch.load] 305 gt 300
441 Can't send connect request to server, No such File or Directory

These errors all mean that the news server has an internal problem unrelated to anything you are 
doing.    Contact your service provider to have it fixed.    When this happens, Agent saves the article 
you were trying to post in its Outbox    (Window | Open Outbox), so that you can try to send it again 
later, after your news server is working properly.

441 Can't generate Message-ID Error 0
The error is generated internally by the server either if the server is unable to obtain the current date 
and time (from itself), or if it is unable to find out its own host name.    All of this happens after Agent 
has posted the article to the server.    We recommend that you contact your service provider and tell 
them about the error, since it indicates a problem with their server.

441 Posted in the Future
This error means the date/time on the article, as sent by Agent, is more than 24 hours later than the 
current date/time on the news server.    You should double-check your PC's date and time, and the 
time zone setting in Agent (on the System Profile page of the Preferences dialog box).

480 Authentication required for command error trying to post
This error means that your news server requires you to provide authentication before you can post.    
You need to check with your service provider to find out exactly what is required.    In most cases, you 
need to supply the server a user name and password.    Once you get this information from your 
provider, you can enter it on the User Profile tab of the Preferences dialog box.

500 Command not Recognized
Your news server is not configured to handle a command issued by Agent (usually the XOVER or the 
XHDR commands for retrieving information about articles).    Agent requires that the server accept 
one of these commands.    You will need to contact your service provider and see if they can provide a
server that honors these commands.

500 Error trying to connect to server
This error    means that Agent is attempting to log you into your news server, but your server doesn't 
actually require a login.    Go to the User Profile tab of the Preferences dialog box and uncheck the 
“Server requires authorization login” box.

502 Authentication Error
Check to see if your news server really requires authentication.    If it doesn't or if you are not sure, 
open the Preferences dialog box, go to the User Profile tab, and uncheck the “Server requires 
authorization login” option.    If you know that your server does require authentication, double-check 
your User Name and Password on this dialog box.

502 You are not in my access file
502 You only have permission to transfer
502 You have no permission to talk

These all indicate that you are not properly set up as an authorized user of the news server.    You will 
have to contact your service provider or news administrator to get this corrected.

550 Addressee unknown
Usually, this means you tried to send an email to someone whose email address was unknown to the 
email server, and the server refused to try to forward the mail to another server.



Errors reported by Winsock
This topic will help you track down errors reported by your Winsock driver and detected by Agent.

10055 WSAENOBUFS
There is not enough memory available for WINSOCK.DLL to create any buffers for Agent.    The 
problem is with low memory (memory below 640k), not overall memory.    Free up more conventional 
memory.

10060 WSAETIMEOUT
This may be a case where Agent loads the WINSOCK.DLL, but the winsock driver fails to load.    Try 
loading the driver prior to Agent.    If this works, then make sure the winsock driver is in the DOS path. 
You may also need to free more conventional memory.

10061 Connection refused by server
This error means that the server is either too busy to accept more connections, or possibly has been 
taken down for maintenance.

11004 Host Name not Found
This error means that the Winsock driver was unable to find the host name for your news (NNTP) or 
mail (SMTP) server.    Double-check the name of these servers in the System Profile page of the 
Preferences dialog box.    Usually, they will be something like "news.company.com" and 
"mail.company.com", where "company.com" is your provider's domain name.    As a workaround, try 
entering the numeric (IP) address for the servers.

11004 No Data of Requested type
An error occurred during initialization of the Winsock driver. Check your Winsock driver setup.



Pressing any buttons while offline causes Agent to hang
Agent is designed to make online and offline newsreading as convenient as possible.    When configured 
for offline use it will automatically connect to your service provider when it needs to go online and 
disconnect as soon as it is through.    To make this process as efficient as possible, you should have only 
one copy of the file WINSOCK.DLL on your drive.    Also, it's best to keep all of the Winsock files (e.g., 
WINSOCK.DLL, TCPMAN.EXE, etc.) in the same directory, and to make sure that this directory is in the 
PATH= statement of your AUTOEXEC.BAT file.



Headers/Articles are marked as read after performing an online task
By default, Agent automatically marks unwanted articles read whenever you retrieve article headers or 
bodies.    This makes it easy for you to find the new articles because they will be the only ones that are 
unread. To change this behavior, uncheck the appropriate box on the Marking Read tab of the Default 
Properties for All Groups dialog box.



How to re-send a failed post or email
By default, whenever you post a message or send an email, Agent saves it in the Outbox. This means 
that if the post fails for any reason, the message is still there and you can try to post it again. To do this, 
select the Post Articles and Emails from the Online menu.

See Also:
Making Sure Articles and Emails Were Sent Properly



Agent failed to decode a binary file
Agent finds the sections of a binary file by searching for articles with identical subject lines, except for the 
"[n/m]" or "n of m" part.    If it finds all the parts, it uses the [n/m] to figure out how to sort them.    In most 
cases, this method works quite well, because most users who post binaries use automated tools (like 
Agent) that conform to this convention.    But, when some users post binaries, they assign a different 
subject line to each article.    When this happens, Agent cannot find all the sections automatically.

The message "Unable to locate any sections" means you selected the [0/m] article, which technically isn't 
part of the binary, and Agent was not able to find articles [1/m] through [m/m].

The message "Only able to locate x of m sections" means that you selected one of the [n/m] sections, but 
Agent couldn't find all of the other m sections.

The message "No binary attachment found" means the binary may have been posted using an encoding 
scheme other than uuencoding. In this case, retrieve the articles as normal message bodies, then export 
the file to text using the Save Article As command from the File menu. The file can then be decoded using
one of the widely available decoding programs such as Wincode or UDEC.

See Also:
How to Retrieve a Binary Attachment



Expand Threads doesn't always work
There are two options on the Navigation tab of the Preferences dialog box (Options menu) that determine 
whether threads are displayed in expanded or collapsed form:

· Show threads initially Collapsed
When checked, all threads will be shown collapsed when you first open a newsgroup. When 
unchecked, they will all be shown expanded.

· Automatically expand threads containing new articles
When checked, threads will be expanded when you jump into them with the Skip to/View Next Unread
Article commands.    Note: They are expanded only if you've already retrieved and read the first article
in the thread.



How to restore a deleted group
Select Refresh Groups List from the Online menu.    This will rebuild your groups list without confusing the
unread counters for your remaining groups.    You won't lose any information by performing this action.

See Also:
Delete Group Command
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Free Agent, News Agent, and Agent are trademarks and Forté is a registered trademark of Forté 
Advanced Management Software Inc.    Copyright © Forté 1995.
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Microsoft is a registered trademark and MS-DOS and Windows are trademarks of Microsoft Corporation.
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TBD - Agent Icons
The following table describes what the icons appearing next to groups and articles represent:

Icon Meaning

The article is in the process of being retrieved.



How to Receive Technical Support
Forté does not provide direct technical support to Free Agent users.    You can, however, receive help with
the program from other users by posting your question in one of the following newsgroups:

· alt.usenet.offline-readers
· alt.winsock
· news.software.readers
· WINCON (CompuServe forum)
Information about the latest Free Agent release and answers to the most frequently asked questions can 
be found on our Web site at http://www.forteinc.com/forte/.    For those without convenient 
Web access, we've prepared a downloadable file containing the text (in HTML format) of our web pages.   
You can find this file on our FTP site at ftp.forteinc.com/pub/forte/support.zip.

See Also:
Frequently Asked Questions







Add Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to enter the name of a new signature.

Name
Enter the name of the new signature



Use Information From Another Program dialog box
Use this dialog box to select the program from which Agent will acquire its basic setup information.

Program
Select the program from which you wish to get the initialization information.

Copy program’s list of newsgroups
Check this box if you want Agent to use the selected program’s newsgroup list to fill in its own list.    If 
you have subscribed to newsgroups in the selected program, you will be subscribed to those groups 
in Agent as well.
Note: If the newsgroup list in the other program is out of date, either uncheck this box or choose 
Refresh Group List from the Online menu at a later time.



Use Information From dialog box
Use this dialog box to enter the location of the program from which Agent will acquire its basic setup 
information.

Enter the name of the directory...
Type in the other program’s complete path, including drive.    For example, C:\TRUMPET.



Window Layout dialog box (Options menu)
Use this dialog box to select the layout of the panes in the current window.    You can choose how the 
panes should be arranged and what the contents of each pane should be.

Layout of Panes
These buttons show all of the available pane layouts.    Click on a button to choose a layout.

Contents of Panes
For the layout you have selected above, these buttons show all of the ways that you can organize the 
Group Pane, Article Pane, and Body Pane.    The box with black text represents the Group Pane.    
Red text represents the Article Pane.    The Body Pane has blue text.    Click on a button to choose an 
organization.

After you have chosen a layout and pressed OK, the window will update to reflect your selection.    If you 
desire, resize the panes by dragging the border between the panes.

TIP:    To show only one pane at a time, select Zoom Window from the Navigate menu or press Z.

If you would like to have a particular layout be the one used when you start Agent or open a new 
Newsgroup window, choose Save As Default Window Layout from the Options menu.    This command 
saves the pane layout, pane sizing, and whether or not a pane is zoomed.



Preferences dialog box (Options menu)
Attachments Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how binary 
attachments sent by you are formatted.    For more information on sending attachments, see How to Send
a Binary Attachment.

Send attachment as multiple messages
Select this option to split long attachments into multiple messages.    The size of each attachment is 
dictated by the number you enter into the Lines per Messages box.

Send attachment as a single message
Select this option to include the entire attachment in one message, no matter how long the 
attachment is.

Send text as preface message
Select this option to send an additional message ahead of the attachment message(s).    This is useful
because it allows people to read a description of the attachment before downloading it.

Send text in first message
Select this option to include the description of the attachment in the attachment’s first message.

Do not send any text
When this option is selected, Agent will only send the attachment.    Any other text or description you 
enter into the Compose window will be ignored.



Preferences dialog box (Options menu)
Colors Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the color of text in 
Agent.

Normal Lines
Choose the color for groups and “read” article headers.

Unread Articles
Choose the color for unread article headers.

Highlighted Unread Articles
Choose the color for unread article headers when they are selected.    This is usually the inverse of 
the Unread Articles color.

Normal Text
Choose the color for body text.

Quoted Text
Choose the color for response text within an article’s body.



Preferences dialog box (Options menu)
Confirmations Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls the confirmation 
messages Agent displays.    These messages warn you when you are about to perform an irreversible 
action.

Delete groups
Check this box and Agent will display a confirmation message when you manually delete a group.

Delete articles or article bodies
Check this box and Agent will display a confirmation message when you manually delete an article or 
its body.

Delete outbox messages
Check this box and Agent will display a confirmation message when you manually delete a posting or 
email in the Outbox window.

Close message composition window
Check this box and Agent will display a confirmation message when you close a posting or email 
window without sending the message first.

Stop online tasks
Check this box and Agent will display a confirmation message when you cancel an online operation.

Close program while online tasks are running
Check this box and Agent will display a confirmation message when you exit Agent while it is 
communicating with the news server.

Mark all articles read or unread
Check this box and Agent will display a confirmation message before marking all the articles in a 
group read or unread.

Default action in confirm dialogs is YES
Check this box to make “Yes” the default button on all confirmation dialog boxes.    The default button 
is the one activated when you press the Enter key.



Preferences dialog box (Options menu)
Display Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent’s 
newsgroup window appears and behaves.

Show Toolbar
Check this box to display the Agent toolbar directly below the menubar.

Show Status Bar
Check this box to display the Agent status bar at the bottom of the window.

Tab Spacing
Enter the length of tab stops, in characters.

Quoted Text
Enter the characters that commonly appear in follow-up messages signifying that text on the same 
line is quoted from the original message.    Agent displays this text in the color defined by the Quoted 
Text setting on this dialog box’s Colors tab.

Scroll Margins
Enter the number of rows you want to remain visible above or below the highlighted row when 
scrolling up or down in the Article and Body panes.

Follow-Up Indentation
Enter the amount of space, in characters, that follow-up articles should be indented from their parent 
in the Article Pane.

Maximum Follow-Up Level
Enter maximum number of response levels (responses to responses) that you want displayed in the 
Article Pane.    Any responses deeper than this appear at the most indented level.



Preferences dialog box (Options menu)
Navigation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how Agent behaves 
when you are navigating within a Newsgroup window.

Skipping to the next unread article...
Check this box and Agent will keep your focus in the same pane when you skip between articles in 
different groups.

Marking or ignoring...
Check this box and Agent will automatically skip to the next unread article after you mark an article for
retrieval or select a thread to be ignored.

Watching an unread article...
Check this box and Agent will automatically skip to the next unread article after you select Watch 
Thread (or press W) when an unread article is highlighted.

Skipping to the next unread group...
Check this box to have Agent automatically mark all the articles in the current group “read” when you 
choose Skip to Next Unread Group.

Show Threads Initially Collapsed
Check this box to initially hide all responses in the Article Pane.

Automatically expand threads containing new articles
Check this box to have Agent automatically expand a thread when skipping to an unread article within
a thread.    Agent expands the thread only if you had previously retrieved and read the first article in 
the thread.

Start a new thread...
Check this box to create a new thread when a follow-up article’s subject is different than the main 
article’s subject.    When unchecked, Agent attaches follow-up articles to the original even when the 
subject of the thread changes.

Enable threading by subject
Check this box to have Agent include articles with the same subject under the same thread, even if 
the follow-up article doesn’t contain a valid reference to the original.    People frequently mispost 
responses and this helps match follow-ups with the article to which they are responses.

Double-clicking an article launches its binary attachment
Check this box and double-clicking on any article containing an attachment you’ve saved will run the 
program associated with the attachment’s file type.    For more information, see How to Configure a 
GIF or JPG Viewer to Work with Agent.

Right mouse button...
Check this box if you want to use the right mouse button to select options from the context menus.    
When unchecked, the left mouse button selects context menu options.

See Also:
Navigating in Agent
Watching and Ignoring Threads



Preferences dialog box (Options menu)
Message Posting Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls how messages that 
you send are formatted.

Line length
Enter the maximum number of characters that can appear on a single line.    Agent automatically word
wraps any lines longer than this.

Save sent messages in outbox
Check this box to save a copy of all messages that you send.    Choose Open Outbox Window from 
the Window menu to view your saved messages.    For more information on the Outbox window, see 
Making Sure Articles and Emails Were Sent Properly.

Include original text
Check this box to include a copy of the original text in follow-up articles or emails.

Quote original text in forwarded emails
Check this box to insert the quote prefix (defined below) in front of each line of text from the original 
posting when forwarding messages to people via email.

Prefix for quoted lines
For follow-up articles and emails, enter the character(s) that signify that the text on the same line is 
quoted from the original message.

Follow-Up article introduction
Enter the text to appear just above quoted lines in follow-up articles.

Email reply introduction
Enter the text to appear just above quoted lines in email replies.

Forward email introduction
Enter the text to appear just above quoted lines in forwarded emails.

For more information, see Composing an Introduction String.

Validate email address
When checked, Agent validates all email address fields (To:, Cc:, etc.) before sending 
messages.    Uncheck this box if you need to enter non-standard addresses.    Note: Agent
does not verify that the email address exists.    It simply checks the format to make sure 
it is a valid Internet email address.



Composing an Introduction String
When you reply to an article, it’s common practice on the Internet to include some of the text from the 
original article in the reply.    It is also common practice to precede the original text with a line such as 
“Jessye Lynn Sidell wrote:” You define this introduction string on the Message Posting tab of the 
Preferences dialog box.

The following table describes the different fields you can include in the introduction string.    When you 
include a field in an introduction string, Agent automatically replaces that field with its value from the 
original article.    To include a field in a string, enclose it within percent signs (e.g., %From%).    Note: To 
include the percent sign in the string, enter two of them next to each other (e.g., %%).

Field Description
Date The date the article was sent.
Reply-To Where the author wanted replies sent.
From The email address of the person who posted the article.
Sender The sender of the article.    Note: This may be a different person than the one in the 

From field if the sender wasn’t the one who actually posted the article.
Full-Name The full name of the author, extracted from the From field.
Subject The brief description of the article.
Message-Id The article’s unique message ID.
Newsgroups The newsgroup to which this article was posted.    If the article was posted to more than 

one group, the current group is used.
Followup-To The newsgroups where the sender of the article wants follow-up articles posted.
Expires The date the article is scheduled to expire.
References For follow-up articles, the message IDs of the articles to which this article refers.
Organization The author’s organization.
Keywords Optional keywords included by the author to help categorize the article.
Summary A summary description of the article.
Lines The number of lines in the article.

You may also use the following to represent special characters:

Character Description
\n The newline character
\t A tab.
\\ The backslash character itself.



Preferences dialog box (Options menu)
Online Operation Tab
Use this dialog box to define settings that affect how Agent works.    This tab controls Agent’s behavior 
while online.

Use Offline Defaults
Press this button if you want to use Agent as an offline newsreader.    This button optimally configures 
the remaining controls in this dialog box for offline use.    For more information, see How to Use Agent 
as an Offline Newsreader.

Use Online Defaults
Press this button if you want to use Agent as an online newsreader. This button optimally configures 
the remaining controls in this dialog box for online use.    For more information, see How to Use Agent 
as an Online Newsreader.

Times to retry when server refuses connection
Enter the number of times Agent should attempt to reconnect to the news server when it refuses a 
connection.    This normally happens when the news server is busy.

Pause between retries
Enter the number of seconds between each reconnection attempt.

Close winsock (hang up) between retries
Check this box to have Agent hang up the modem between reconnection attempts.

Go offline automatically after...
Enter the number of seconds of inactivity that Agent waits before automatically disconnecting from 
your news server.    If you uncheck this box, Agent will not disconnect from your news server until you 
close the program or uncheck Online from the Online menu.

If you intend to read articles online, you might want Agent to go offline after a few minutes of inactivity.
This gives you time to read articles, but doesn't leave Agent online too long.    If you intend to read 
articles offline, you probably want Agent to go offline immediately (0 seconds of inactivity).

Send keep-alive messages every...
When this box is checked, Agent sends a command to your news server periodically in order to 
maintain the connection to the server.    This option is useful if your computer is connected to the 
server via a dial-up channel that automatically disconnects after a period of inactivity. 

Enter the frequency of keep-alive messages sent from Agent to your news server.    Uncheck this box 
and Agent won’t send any keep-alive messages.

Enable priority article retrieval
When this box is checked, Agent opens a second channel to the news server when you attempt to 
retrieve the body of an article while Agent is already busy performing other online operations.    This 
makes it possible for you to begin reading new articles in one group while retrieving headers in 
another. 

Viewing Unretrieved Articles When Offline
Select the action you want Agent to perform when you are offline and attempt to view an article for 
which you do not have the body.    This setting affects double-clicking and pressing Enter on articles, 
as well as the View Next Unread Article and View Next Unread Article in Thread actions on the 
Navigate menu.

See Also:
Online Menu Commands Explained



Preferences dialog box (Options menu)
System Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information that is 
required to use Agent.

News Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Time Zone
Select the time zone you are located in.    Agent uses this setting to convert the times of articles to 
your own local time.    Also, when you post an article or email message, Agent includes your time zone
in the date.

Automatically adjust for Daylight Savings Time
Check this box if you live in a locality that observes Daylight Savings Time between April and October.
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.



Preferences dialog box (Options menu)
User Profile Tab
Use this dialog box to define settings that affect how Agent works.    This tab defines information about 
you.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: lance.boehm@forteinc.com.

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some news readers, such as Agent, can display an author’s full name rather than his/her email 
address.

Organization
(Optional) Enter the name of the organization to which you belong.    This name is sent in the 
"Organization" field of articles that you post.    It is not included in your email messages.

Reply To
(Optional) Enter an email address here if you want people to send replies to an address that is 
different than your Email Address listed above.    For example, you may use your business address as
your Email Address, but would prefer that replies be sent to a personal email address.

Note:    Changing the Email Address, Full Name, Organization, or Reply To value here also changes the 
corresponding field on the Posting tab of the Default Properties for All Groups dialog box.

Server requires authorization login
Check this box if your news server requires a special user name and/or password to login.    When 
checked, Agent will automatically fill in your user name when requested by the news server.

User Name
Enter the user name required by your news server for logging in.

Remember password between sessions
Check this box if your news server requires a special password to login and you want Agent to 
automatically enter that password for you.

Password
Enter the password required by your news server for logging in.    Your password is encrypted and 
then stored in AGENT.INI.

Note: You must take Agent offline and then back online for changes to the user name or password to take 
effect.



Properties for Selected Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls when Agent marks articles read.    Usually, you'll want to mark all existing articles read 
each time you retrieve new articles so that only the new articles are marked unread.    That way, it's easy 
for you to find the new articles. 

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

New article headers
Check this box to mark all existing articles read each time you retrieve new article headers for this 
group.

Marked article bodies
Check this box to mark all existing articles in this group read each time you retrieve marked article 
bodies for this group.    All the new articles Agent retrieves will be marked unread so that you can 
easily find them.

See Also:
Marking Articles Read



Default Properties for All Groups dialog box (Group menu)
Marking Read Tab
Use this dialog box to define your default group settings.    This tab controls when Agent marks articles 
read.

Usually, you'll want to mark all existing articles read each time you retrieve new articles so that only the 
new articles are marked unread.    That way, it's easy for you to find the new articles. 

New article headers
Check this box to mark all existing articles read each time you retrieve new article headers.

Marked article bodies
Check this box to mark all existing articles read each time you retrieve marked article bodies. All the 
new articles Agent retrieves will be marked unread so that you can easily find them.

See Also:
Marking Articles Read



Properties for Selected Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how postings to this group or email replies from this group are handled.    Note: All of 
these settings can be overriden for a particlular message.    See the Compose Article window and the 
Compose Email window for details.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.    Note: Checking this box only overrides the “Copy follow-up 
articles to author via email,” “Signature,” and “Spell Check Language” settings.    Each field in the 
“Fields” list must be overridden independently (see below for details).

Copy follow-up articles to author via email
When checked, Agent will send a copy of follow-up articles you post to the author of the article to 
which you are responding.

Signature
Select a signature to use for posting to this group or email replies from this group.

Spell Check Language
(Not available in Free Agent) Select the language dictionary to use when spell checking posting to this
group or email replies from this group.    For more information, see About Agent’s Dictionaries.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Article and Email Fields for a description of each field.    Setting a default value 
for these fields saves you time when posting articles and sending emails because you don’t have to 
reenter the common information for each message.    You can even default the Newsgroups field
to automatically cross-post articles to several groups.
To change a particular field’s default value, highlight the field, check the “Override default value for 
field” box, and enter the new value in the “Value for <Field>“ control.

Override default value for field
Check this box to use the default field value defined on this tab instead of the one defined in the 
Default Properties for All Groups dialog box.

Value for <Field>
Enter the default value for the field selected in the Fields list.    You must check the “Override default 
value for field” box before you can enter a value here.

See Also:
Compose Article window
Compose Email window
How to Post Articles
How to Send Email



Default Properties for All Groups dialog box (Group menu)
Posting Tab
Use this dialog box to define your default group settings.    This tab controls how postings are handled.    
Note: All of these settings can be overriden for a particlular message.    See the Compose Article window 
and the Compose Email window for details.

Copy follow-up articles to author via email
When checked, Agent will send a copy of follow-up articles you post to the author of the article to 
which you are responding.    You can easily override this behavior for individual follow-ups by 
removing the author’s name from the Email To field on the Compose Article window.

Signature
Select a default signature for all your postings and emails.    Note: Changing this setting here also 
changes the Default Signature defined in the Signatures dialog box.

Spell Check Language
(Not available in Free Agent) Select a default language dictionary for all your postings and emails.    
Note: Changing this setting here also changes the Default Language defined on the Spelling tab of 
the Preferences dialog box.    For more information, see About Agent’s Dictionaries.

Fields
This list contains all the Usenet message fields (and some email ones as well) for which you can set 
default values.    See Article and Email Fields for a description of each field.    Setting a default value 
for these fields saves you time when posting articles and sending emails because you don’t have to 
reenter the common information for each message.  Note: The global defaults for the From, 
Organization, and Reply-To fields also appear on the User Profile tab of the Preferences 
dialog box.    Changing these fields here also changes them in that dialog box (and vice 
versa).
To change a particular field’s default value, highlight the field and enter the new value in the “Value for
<Field>“ control below.

Value for <Field>
Enter the default value for the field selected in the Fields list.

See Also:
Compose Article window
Compose Email window
How to Post Articles
How to Send Email



Properties for Selected Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls which articles Agent automatically purges (deletes).    To control when Agent purges 
articles, see the When to Purge tab of the Properties for Selected Groups dialog box.    For more 
information on purging in general, see About Article Purging.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Configure Agent’s Hard Disk Usage
The buttons in this box help you define the purging options below.    Agent maintains a database of 
articles for each group and these buttons provide presets for common configurations.    After pressing 
one of these buttons, check the other values in the dialog box and change them to meet your specific 
requirements.

Purge Read Articles Without Bodies
This control defines when Agent purges articles you did not retrieve but marked read.    Usually, these 
are articles that you are not interested in reading.    For more information on each option in the list, 
click On every purge, When the article is older than, and When the article is no longer available.

Purge Read Articles With Bodies
This control defines when Agent purges articles you have retrieved and read.    For more information 
on each option in the list, click On every purge; On every purge, delete body only; When the article is 
older than; and Never.

Purge Unread Articles Without Bodies
This control defines when Agent purges articles you have not retrieved or marked read.    Usually, you 
haven’t yet decided if you want to read these articles.    For more information on each option in the list,
click On every purge, When the article is older than, and When the article is no longer available.

Purge Unread Articles With Bodies
This control defines when Agent purges articles you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the article is older than; and Never.

Always get complete list of available articles from server
When checked, Agent retrieves a complete list of available articles whenever it gets new headers.    
This option is useful (but not required) when you have selected the “When the article is no longer 
available” option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 articles, it increases the download time by about five 
seconds for a 14.4 kbps modem connection.

When unchecked, Agent purges articles with numbers lower than the range of available articles 
reported by the news server.    Since there are often gaps in the available range of articles, this setting
may cause Agent to keep articles that are no longer available.

See Also:
Marking Articles Read
Compacting Agent’s Database Files



Default Properties for All Groups dialog box (Group menu)
What to Purge Tab
Use this dialog box to define your default group settings.    This tab controls which articles Agent 
automatically purges (deletes).    To control when Agent purges articles, see the When to Purge tab of the 
Default Properties for All Groups dialog box.    For more information on purging in general, see About 
Article Purging.

Configure Agent’s Hard Disk Usage
The buttons in this box help you define the purging options below.    Agent maintains a database of 
articles for each group and these buttons provide presets for common configurations.    After pressing 
one of these buttons, check the other values in the dialog box and change them to meet your specific 
requirements.

Purge Read Articles Without Bodies
This control defines when Agent purges articles you did not retrieve but marked read.    Usually, these 
are articles that you are not interested in reading.    For more information on each option in the list, 
click On every purge, When the article is older than, and When the article is no longer available.

Purge Read Articles With Bodies
This control defines when Agent purges articles you have retrieved and read.    For more information 
on each option in the list, click On every purge; On every purge, delete body only; When the article is 
older than; and Never.

Purge Unread Articles Without Bodies
This control defines when Agent purges articles you have not retrieved or marked read.    Usually, you 
haven’t yet decided if you want to read these articles.    For more information on each option in the list,
click On every purge, When the article is older than, and When the article is no longer available.

Purge Unread Articles With Bodies
This control defines when Agent purges articles you have retrieved but not yet read.    For more 
information on each option in the list, click On every purge; On every purge, delete body only; When 
the article is older than; and Never.

Always get complete list of available articles from server
When checked, Agent retrieves a complete list of available articles whenever it gets new headers.    
This option is useful (but not required) when you have selected the “When the article is no longer 
available” option in one of the controls above.    It does, however, increase the time required to get 
new headers.    For a group containing 500 articles, it increases the download time for each group by 
about five seconds for a 14.4 kbps modem connection.

When unchecked, Agent purges articles with numbers lower than the range of available articles 
reported by the news server.    Since there are often gaps in the available range of articles, this setting
may cause Agent to keep articles that are no longer available.

See Also:
Marking Articles Read
Compacting Agent’s Database Files



On every purge
Select this option to purge this type of article every time Agent purges any articles from the group.    This 
option reduces the amount of clutter in the Article Pane, but prevents you from reading articles that you 
may have overlooked in previous sessions.



When the article is older than
Select this option to purge this type of article when it is older than the specified number of days.



When the article is no longer available
Select this option to purge this type of article when it is purged from the news server’s list of articles.    
This setting makes the list of articles displayed by Agent a mirror image of the articles available from the 
server.



On every purge, delete body only
Select this option to purge the body of this type of article every time Agent purges any articles from the 
group.    Purging only bodies saves hard disk space while still allowing you to maintain a complete list of 
articles.



Never
Select this option to prevent articles of this type from being purged.    As an alternative, you may want to 
consider keeping the important articles (highlight the article and choose Keep Article from the Article 
menu) and select one of the other purge options.



Properties for Selected Groups dialog box (Group menu)
When to Purge Tab
This tab controls when Agent automatically purges (deletes) articles.    To control which articles Agent 
purges, see the What to Purge tab of the Properties for Selected Groups dialog box.    For more 
information on purging in general, see About Article Purging.

Note: These control affect when all groups are purged, not just the selected one.

Purge - When retrieving new headers
When checked, Agent purges articles from a group when it retrieves new headers for that group.

Purge - When closing Agent
When checked, articles from all groups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Articles option from the Group menu also compacts the databases 
being purged.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the “Compact only if wasted space at least...” field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
“Compact only if wasted space at least...” field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the operation if only a small amount of disk 
space would be saved.    Enter the minimum amount of disk space savings, as a percentage of the 
total size of the database, that will cause Agent to perform an automatic compaction after either a 
manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent’s Database Files



Default Properties for All Groups dialog box (Group menu)
When to Purge Tab
Use this dialog box to define your default group settings.    This tab controls when Agent automatically 
purges (deletes) articles.    To control which articles Agent purges, see the What to Purge tab of the 
Default Properties for All Groups dialog box.    For more information on purging in general, see About 
Article Purging.

Purge - When retrieving new headers
When checked, Agent purges articles from a group when it retrieves new headers for that group.

Purge - When closing Agent
When checked, articles from all groups are purged when you exit Agent.

Compact - After manual purges
When checked, selecting a Purge Articles option from the Group menu also compacts the databases 
being purged.    Note: A database is compacted only when the percent of disk space saved is greater 
than the value entered in the “Compact only if wasted space at least...” field below.

Compact - When closing Agent
When checked, Agent will compact all your databases when it closes.    Note: A database is 
compacted only when the percent of disk space saved is greater than the value entered in the 
“Compact only if wasted space at least...” field below.

Compact only if wasted space at least...
Before compacting a database, Agent checks to see how much disk space would be saved by the 
compact operation.    This setting allows you to bypass the operation if only a small amount of disk 
space would be saved.    Enter the minimum amount of disk space savings, as a percentage of the 
total size of the database, that will cause Agent to perform an automatic compaction after either a 
manual purge and/or an automatic purge during exit.

When closing Agent, prompt for confirmation...
When checked, Agent asks for confirmation before purging and/or compacting databases when you 
close the program.    When unchecked, the Agent will purge and/or compact the databases without 
asking first.    Note: To purge or compact databases on exit, be sure to check the appropriate box 
above.

See Also:
Compacting Agent’s Database Files



Properties for Selected Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab controls how and what Agent retrieves from the news server.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Retrieve bodies for all new articles
Check this box to have Agent automatically retrieve the bodies for all new articles at the same time it 
retrieves the headers.    This option is handy if you know you'll always want to read all of the articles in
a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you probably don't want 
to select this option for all groups.

Do not retrieve articles longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the articles in a particular group, but not 
necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually over 
200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent articles.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty group.

Maximum articles to sample
Enter the maximum number of articles to sample.

Highest article retrieved
This is the highest article number Agent has retrieved for this group.    When you get new headers in 
this group, Agent will retrieve all articles whose number is greater than this value.    You may never 
need to change this setting.    To get all the articles in a group, regardless of the high article number, 
choose Get All Headers in Selected Groups from the Online menu.    To set the high article number to 
the highest value on your news server without retrieving all the new headers in the group, choose 
Catch Up With Selected Groups from the Online menu.

See Also:
Online Menu Commands Explained



Default Properties for All Groups dialog box (Group menu)
Retrieving Tab
Use this dialog box to define your default group settings.    This tab controls how and what Agent retrieves 
from the news server.

Retrieve bodies for all new articles
Check this box to have Agent automatically retrieve the bodies for all new articles at the same time it 
retrieves the headers.    This option is handy if you know you'll always want to read all of the articles in
a particular group.    Of course, it takes a lot longer to retrieve the bodies, so you probably don't want 
to select this option for all groups.

Do not retrieve articles longer than...
Check this box and enter a value to limit the size of bodies that are automatically retrieved by the 
option above.    For example, you may want to read most of the articles in a particular group, but not 
necessarily download the group's FAQ every time it is posted.    If you know the FAQ is usually over 
200 lines long, limit the maximum size to 200 lines.

Limit number of headers retrieved per session to...
Check this box and enter a value to limit the number of headers retrieved each time you retrieve new 
headers for the group.    For example, if you limit the number to 100 headers, Agent will retrieve no 
more than the 100 most-recent articles.    This option is handy if you want to catch up with a busy 
group, and know you can't possibly read all the messages posted since you last checked.    Note: This
setting only affects the Get New Headers in Subscribed Groups and the Get New Headers in 
Selected Groups commands.    For more information on these commands, see Online Menu 
Commands Explained.

View Empty Group Action
Select the option corresponding to the action you want Agent to take when you double-click or press 
Enter on an empty group.

Maximum articles to sample
Enter the maximum number of articles to sample.

See Also:
Online Menu Commands Explained



Properties for Selected Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define settings for the selected group.    TIP:    If you highlight several groups before
opening this dialog box, you will be changing the settings for all the selected groups at once.

This tab defines the directory where Agent saves binary attachments.

Override default settings
Check this box to use the settings defined on this tab instead of those defined in the Default 
Properties for All Groups dialog box.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Default Properties for All Groups dialog box (Group menu)
Attachments Tab
Use this dialog box to define your default group settings.    This tab defines the directory where Agent 
saves binary attachments.

Binary Attachments Directory
Enter the directory where you want Agent to save binary attachments.

See Also:
How to Retrieve a Binary Attachment
How to Configure a GIF or JPG Viewer to Work with Agent



Find dialog box (Edit menu)
Use this dialog box to find a group or article.

Find What
Enter the text to search for.

Find First
Press this button to find the first occurrence of the text you entered above.

Find Next
Press this button to find the next occurrence of the text you entered above.

See Also:
Finding Groups or Articles



Licensing Agreement dialog box
This dialog box displays Agent’s licensing terms and conditions.    You must accept the terms and 
conditions in order to run the program.

Accept
Press this button to accept the terms of the agreement and run Agent.

Decline
Press this button if you do not accept the terms of the agreement.    Agent will not run if you press this 
button.



Page Setup dialog box (File menu)
Use this dialog box to control the format of articles printed with Agent.

Margins
Enter the left, right, top, and bottom margins in inches.

No fields (Body only)
Select this option to print only the article bodies.

Newsgroup, subject, author, and date
Select this option to print some of the header information along with the article bodies.

All fields
Select this option to print all of the header information along with the article bodies.

None
Select this option to print articles one after the other.

Between articles
Select this option to insert a page break between each article being printed.

Between threads
Select this option to print all the articles in the same thread one after the other and to insert a page 
break between articles of different threads.

Font
Press this button to pick the font used when printing articles.

See Also:
Printing Articles



Server Authorization Password dialog box
Use this dialog box to enter the password required to login to your news server.

Password
Enter the password required by your news server.

Remember password between sessions
Check this box if you want Agent to automatically enter that password for you each time you login to 
the news server.



Refresh Groups List dialog box (Online menu)
Use this dialog box to update your group list and define what Agent should do with groups it no longer 
finds on the news server.

The refresh operation retrieves a complete list of all newsgroups available form the server.    It then adds 
any new groups to Agent’s list of groups, and optionally deletes any groups that are no longer available.    
TIP:    If you only want to retrieve new groups added since the last time you updated your group list, 
choose Get New Groups from the Online menu.

Note:    Since this operation retrieves a complete list of groups, it can take several minutes to complete.

Keep all extinct groups
Select this option to maintain groups even if they no longer exist on the server.

Delete extinct groups that are empty
Select this option to maintain groups that no longer exist on the server if the group contains articles.

Delete all extinct groups
Select this option to delete any group which no longer exists on the server.

See Also:
Online Menu Commands Explained



Rename Signature dialog box (Signatures dialog box, Options menu)
Use this dialog box to change the name of a signature.

New Name
Enter a new name for the signature.



Save Articles As dialog box (File menu)
Use this dialog box to save one or more articles to a text file.    Note: Agent only saves articles whose 
bodies have been retrieved.

Select all the articles you want to save before choosing this menu option.    If you select a collapsed 
thread, Agent will save all articles in the thread.

File Name
Enter the name of the file you want to save to, or select a file from the list of files. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to display in the list of files. 

Drives
Select the drive where you want to save the file. 

No fields (Body only)
Select this option to save only the article bodies.

Newsgroup, subject, author, and date
Select this option to save some of the header information along with the article bodies.

All fields
Select this option to save all of the header information along with the article bodies.

Append to Existing File
Check this box if you want to append the articles to an existing file.    If you uncheck this option and 
save the articles to an existing file, Agent will erase the current contents of the file.

See Also:
Printing Articles



Agent Setup dialog box
Fill in this dialog to provide Agent with the basic information needed to read articles and post messages.    
If you don’t want to post articles or emails, you only need to supply the name of your news server and 
your time zone.    You can enter the other information later in the Preferences dialog box.

Use Information From Another Program
If you’re already using one of the listed programs, Agent can get most of its basic setup information 
from the other program's configuration files.    Press this button to select the program you use.

News (NNTP) Server
Enter the name of your news (NNTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email (SMTP) Server
Enter the name of your email (SMTP) server or its IP address.    If you don't know the name, ask your 
service provider or system administrator.

Email Address
Enter your email address.    When you send a message, this address appears in the "From" field.    
For example: john.doe@forteinc.com

Full Name
(Optional) Enter your full name.    This name is included with your email address in messages that you
send.    It is helpful to include your full name if your email address does not contain your name.    Also, 
some news readers display full names, when available, rather than email addresses.

Time Zone
Select the time zone you are located in.    Agent uses the time zone to convert the dates of articles to 
your own local time.    Also, when you post an article or email message, Agent includes your time zone
in the date.

Automatically adjust for Daylight Savings Time
Check this box if you live in a locality that observes Daylight Savings Time between April and October.
During these months, Agent automatically adjusts your time zone to compensate for the time 
difference.

Spell Check Language
(Not available in Free Agent) Select the default language dictionary to use for spell checking 
messages.    For more information, see About Agent’s Dictionaries.

Exit Agent
Press this button if you don’t have the basic information available.    The next time you run Agent, this 
dialog box will be displayed again.



Signatures dialog box (Options menu)
Use this dialog box to define the signatures you wish to use in your own postings and emails.

Names
This is a list of the signatures you have defined.    To edit a signature, select it in this list and enter the 
new text in the controls below.

Add
Press this button to create a new signature.

Rename
Press this button to rename the signature highlighted in the Names list.

Delete
Press this button to delete the signature highlighted in the Names list.    If you accidentally delete a 
signature, press the Cancel button to close the dialog box and cancel all of your changes.

Default Signature
Select the signature you wish to use by default.    Select [None] if you don't want to have a default 
signature.    When you post an article or send an email message, Agent automatically uses your 
default signature.    You can choose a different signature to be the default for each group (see the 
Posting tab of the Properties for Selected Groups dialog box) or override the signature used for a 
specific message (see the Compose Article window).    Note: Changing this setting here also changes 
the signature set on the Posting tab of the Default Properties for All Groups dialog box.

Text
Enter the text of the signature highlighted in the Names list. If you want a blank line or other separator
to appear between the rest of the message and the signature, you need to include it here.    To insert 
a TAB in the text, press Ctrl+TAB.

TIP:    A common convention on the Internet is to begin your signature with a line containing two 
dashes.    For example:

--
Dave Chin
Forte, Inc.

Use existing file
If you want to share a signature file with another program, enter the name of the file that contains the 
signature.    When you have entered a valid file name, the dialog will display the contents of the file in 
the Text field.    Any changes you make to the signature in this dialog box will be saved to the file, so 
changes here also affect any other program that is using the same file.

TIP: The name of the signature file for the Eudora email program is SIGNATUR.PCE, and it is stored 
in the directory where you installed Eudora.

Browse
Press this button to browse for a signature file.

See Also:
How to Post Articles
How to Send Email



Signatures
A signature is one or more lines of text that Agent automatically places at the bottom of articles and email 
messages that you send.
You can define as many signatures as you wish.    When you create a new message, you can select 
which signature to use with that message.    For example, you can define a "personal" signature and a 
different "business" signature.



Save Binary Attachment dialog box (File menu)
Use this dialog box to manually save an attachment when Agent can’t automatically find all the articles 
composing the attachment.    For more information on retrieving attachments, see How to Retrieve a 
Binary Attachment.

Articles
This is a list of all the articles you selected before opening the dialog box.    If this list does not contain 
all the articles in the attachment, press Cancel and select the remaining articles by holding down the 
Control key and clicking on them.    If the articles are out of order, press the Up and Down buttons to 
get them in order.

Up / Down
Press these buttons to move the highlighted article up or down in the list.    Before launching or saving
an attachment, you must make sure that the articles are in the correct order.

Launch
Press this button to view the attachment.    Agent first saves the attachment (see below for more 
information) and then passes it to the application associated with the attachment's file type.    For 
more information, see How to Configure a GIF or JPG Viewer to Work with Agent.

Save
Press this button to save the attachment as a file.    Agent saves the attachment in the directory 
specified in the Attachments tab of the Properties for Selected Groups dialog box.

If you are offline and have not yet retrieved the attachment’s articles, Agent will immediately go online to 
download and decode the attachment after you press Launch or Save.



View Empty Group dialog box
This dialog box is displayed when you double-click or press Enter on a group with no articles and your 
View Empty Group Action in the Retrieving tab of the Properties for Selected Groups dialog box is set to 
“Prompt for action.”

Sample 50 Article Headers
Press this button to retrieve a maximum of 50 article headers for this group.    Note: The number you 
see may not be 50.    The sample size is defined in your Default Properties for All Groups dialog box 
on the Retrieving tab.

Get All Article Headers
Press this button to retrieve all article headers in this group.

Subscribe to Group
Press this button to subscribe to the group.    You can retrieve article headers later by choosing Get 
New Article Headers in Subscribed Group from the Online menu.

See Also:
Online Menu Commands Explained



Select Signature File dialog box (Signatures dialog box, Options menu)
Use this dialog box to find a signature file on your hard disk.

File Name
Enter the name of the signature file, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.



Save Attachment File dialog box (View Binary Attachment dialog box, File menu)
This dlg is obsolete.
Use this dialog box to save an attachment as a file.

File Name
Enter the name of the file. 

Directories
Select the directory where you want to save the file. 

List of File Types
Select the type of file you want to save the attachment as.

Drives
Select the drive where you want to save the file.



Attach Binary File dialog box (Compose window)
Use this dialog box to attach a binary file to a message.    Agent will automatically uuencode the file for 
you.    Note: If you want to insert a text file into the message, choose Insert Text File from the File menu 
instead.

File Name
Enter the name of the file to attach, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Articles
How to Send Email



Insert Text File dialog box (File menu)
Use this dialog box to insert a text file into a message.

File Name
Enter the name of the file to insert, or select a file from the list. 

Directories
Select the directory where you want to select the file from. 

List of File Types
Select the type of files you want to display in the files list. 

Drives
Select the drive where you want to select the file from.

See Also:
How to Post Articles
How to Send Email



Browser Font dialog box (Options menu)
Use this dialog box to pick the font that groups and articles are displayed in.
Note: Article subjects are displayed in the font controlled by the Article Subject Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options



Article Subject Font dialog box (Options menu)
Use this dialog box to pick the font that article subjects are displayed in.
Note: The other items in the Article Pane (e.g., number of lines and author) use the font controlled by the 
Browser Font dialog box.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular.    Article subjects can be 
easier to read if you select a bold font style.

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options



Variable-Pitch Body Font dialog box (Options menu)
Use this dialog box to pick the variable pitch font that article bodies are normally displayed in.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options
Fixed-Pitch Body Font dialog box



Fixed-Pitch Body Font dialog box (Options menu)
Use this dialog box to pick the fixed pitch font that article bodies are displayed in when you choose Fixed 
Pitch Font from the Article menu.

Font
Type or select a font name.    Courier and Courier New are two examples of fixed pitch fonts.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.

See Also:
Message Text Display Options
Variable-Pitch Body Font dialog box



Printer Font dialog box (Page Setup dialog box, File menu)
Use this dialog box to pick the font that articles will print in.

Font
Type or select a font name.

Font Style
Select a style. To use the default type style for a given font, select Regular. 

Size
Type or select a size.

Sample
Shows a sample of the font as it will appear in the window.



How to Send a Binary Attachment
Attaching files to articles and emails is quick and easy with Agent.    Since the Usenet only supports text 
postings, agent automatically translates (uuencodes) all non-text attachments to a standard text-based 
format.    Follow the steps below to attach a file to a message:

1. Create a new article or email message.
Select one of the options on the Post menu to create the message.    Click here for more help sending
articles and emails.

2. Attach the desired file.
Press the Attachment button to browse for the file, or type the file’s name directly into the Attachment 
box.    You can control your attachment options with the Attachments tab on the Preferences dialog 
box.

3. Add a text message (optional).
You can include a message along with the attachment.    The message appears before the 
attachment. If you include a message, Agent also includes your signature.

4. Send the message.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note:    Agent does not make a copy of the attached file prior to sending it.    If you press 
Send Later, make sure that the file stays around until you transmit it.

See Also:
Making Sure Articles and Emails Were Sent Properly



How to Retrieve a Binary Attachment
Many newsgroups are devoted to the distribution of binary files, typically pictures and sounds.    These 
binary files are posted as text attachments to one or more articles.    Agent makes quick work of 
translating (uudecoding) the text attachments into their binary equivalent.    To retrieve an attachment, 
follow the steps below.

1. Select any article in the attachment.
In most cases, Agent will be able to find all the articles which compose the attachment.    If it can’t, 
usually because the attachment was not posted in one of the standard ways (see How Agent finds all 
the parts of an attachment), follow the steps under “To manually save a binary attachment” below.

If you select articles from more than one attachment, Agent will retrieve all the attachments that have 
any articles selected.

2. Retrieve and/or view the attachment.
Choose either Save Binary Attachments or Launch Binary Attachments from the File menu.    Agent 
saves all attachments in the directory entered in the Attachments tab of the Properties for Selected 
Groups dialog box.

If you are configured for online use (see the Online Operation tab of the Preferences dialog box for 
details), Agent will immediately begin downloading and decoding the attachment.    Also, if you 
selected the Launch option, once the file has been saved, Agent will run the Windows application 
associated with the attachment's file type (see below).

If you are configured for offline use, Agent will mark all parts of the attachment for retrieval.    The next 
time you select Get Marked Article Bodies from the Online menu, Agent will download and decode the
selected attachments (but not automatically launch them).

Once an attachment is retrieved, the Binary Article icon  appears next to all the articles in the 
attachment.    To view the attachment, simply double-click or press Enter on any one of its articles.    This 
causes Agent to launch the application associated with the attachment's file type.    The file type is 
determined by the attachment's filename extension.    For example, "foo.gif" is a GIF file.    For more 
information, see How to Configure a GIF or JPG Viewer to Work with Agent.

After you have viewed an attachment, you may decide that you want to remove it from your hard drive.    
Although you can obviously do this in another program such as File Manager, Agent makes it easy for you
to remove attached files.
To delete a binary attachment:
1. Select any article in the attachment.
2. Choose Delete Selected Binary Attachments from the File menu.

Occasionally, you may find multi-part attachments whose subject lines do not match standard convention 
(e.g., they don't include the typical [1/2], [2/2] notation).    To decode such files, you must tell Agent about 
all of the attachments components.

To manually save a binary attachment:
1. Select all the articles that contain the attachment by clicking on one article and then, with the Control 

key depressed, clicking on the remaining articles.
2. Choose Manually Save Binary Attachment from the File menu.
3. Make sure the articles are in order.    If they are not, use the Up and Down buttons in the Save Binary 

Attachment dialog box to order them.
4. Launch or save the attachment by pressing the corresponding button.    If you are offline and have not

yet retrieved the attachment’s articles, Agent will immediately go online to download and decode the 
attachment.



How Agent finds all the parts of an attachment
Agent finds the sections of a binary attachment by searching the current group for articles with identical 
subjects, except for the “[n/m]” or “n of m” part.    In most cases, this works quite well because people 
generally use automated tools (like Agent) to post attachments.    Unfortunately, some people assign 
different subjects to each article (e.g., “foo.jpg [8/8] -- last one!!”).    When this happens, you can still save 
the attachment by selecting all of its sections and choosing Manually Save Binary Attachment from the 
File menu.



Getting Started
Getting up and running with Agent is simple.    Just follow the steps below and you’ll be reading articles in 
no time.

1. Set your online preferences.
Choose Preferences from the Options menu and select the Online Operation tab.    If you wish to stay 
online with your service provider while using Agent, press the Use Online Defaults button.    If you 
wish to minimize your time online, press the Use Offline Defaults button.

2. Get a list of groups.
If you did not copy the list of newsgroups from another program or retrieve a complete list when you 
first started Agent, select Refresh Group List from the Online menu.    Since there are several 
thousand groups, this may take a while.    Once the groups are retrieved, Agent will display them in 
the Group Pane.

3. Subscribe to groups.
Scan through the list of groups for ones you want to follow regularly.    To find a particular group, 
choose Find from the Edit menu.

When you find a group that may be of interest, double-click on it.    If you want get a feel for the group 
before subscribing, press the Sample 50 Article Headers button.    If you know you’re interested in the 
group, press the Subscribe to Group button.

If you decide later that you’re interested in a group, you can subscribe to it by selecting Subscribe 
from the Group menu.    A newspaper  appears next to each subscribed group.

To unsubscribe from the group, choose the Subscribe menu option again.
4. View only subscribed groups.

From the Group menu, choose Show Only Subscribed Groups.    Now your group pane is filtered to 
show only the groups you’re interested in.    To view all groups again, select Show All Groups from the
Group menu.

5. Retrieve article headers in your subscribed groups.
Choose Get New Headers in Subscribed Groups from the Online menu to download all the article 
headers in all your subscribed groups.

There may be several hundred new articles for each group so this operation may take a while.    But, 
since Agent retrieves articles in the background, you can use your computer for other tasks while 
Agent is working.

6. Browse the article headers.
Once the article headers are retrieved, browse them to see which ones interest you.    If you’re using 
the online defaults, simply double-click or press Enter on an article to retrieve it (see How to Use 
Agent as an Online Newsreader for more information).    If you’re using the offline defaults, mark all 
the articles your interested.    To mark an article, select it and press “M” or choose Mark for Retrieval 
from the Article menu.    When an article is marked, the download arrow  appears next to it.

7. Retrieve marked articles.
If you’re using the offline defaults you marked several articles in the previous step.    To retrieve the 
full text of all marked articles, select Get Marked Article Bodies from the Online menu.    See How to 
Use Agent as an Offline Newsreader for more information.

TIP: Clicking the right mouse button in a Newsgroup window displays a Context menu, a context-sensitive
list of common operations.    Simply select an option from the list to quickly perform that action.

See Also:
How to Use Agent



Toolbar
The toolbar contains buttons which give you fast access to the most common actions in Agent.
To see what a particular toolbar button does, move the mouse cursor over the button in Agent and a 
ToolTip box will appear with the button’s name.



Group Pane
This is where a list of newsgroups is displayed.    In this pane you can view all newsgroups, only 
subscribed newsgroups, or only new newsgroups.    To change which groups are displayed, choose the 
appropriate option from the Group menu.
TIP: You can also change which groups are displayed by clicking on the header for the group list pane 
(the gray area just above the list).



Article Pane
This is where the articles in the selected group are displayed.    To view articles in another group. select 
that group in the Group pane.



Unread Counter
This number shows you how many articles in the associated group you have not yet read.



Ignore Thread Icon
When this icon appears next to an article, Agent will not retrieve new responses to the article.    To switch 
between ignoring and not ignoring a thread, select Ignore Thread from the Article menu.



Expand Thread Icon
Click this icon to show the article’s responses.



Collapse Thread Icon
Click this icon to hide the article’s responses.



Number of Responses
This is the number of responses to the article.    To view the responses, click the Expand Thread icon .



Number of Lines
This is the number of lines in the article.



Article Body Icon
This icon tells you that the body of the article has been retrieved.



Article Body Not Available Icon
This icon tells you that the article has been deleted from your news server and is no longer available for 
retrieval.



Retrieval Icon
This icon tells you that the body of the article is currently being retrieved.



Watch Thread Icon
This icon tells you that Agent will automatically retrieve the bodies of new responses to this article when 
retrieving new article headers.    To switch between watching and not watching a thread, select Watch 
Thread from the Article menu.



Unread Article
When an article header is displayed in this color it means that you have not yet viewed the article’s body.



Read Article
When an article header is displayed in this color it means that you have already viewed the article’s body.



Mark for Retrieval Icon
This icon tells you that the body of the associated article will be retrieved the next time you select Retrieve
Marked Articles from the Online menu.

When this icon appears next to a group, one or more articles in the group are marked for retrieval.

To mark or unmark an article, select Mark for Retrieval from the Article menu.



Keep Article Icon
This icon tells you that Agent will not automatically delete (purge) the article.    To prevent an article from 
being automatically purged, select Keep Article from the Article menu.    To undo the Keep status, select 
Keep Article again.



Body Pane
This is where an article’s text is displayed.    To view a different article’s body, select the article in the 
article pane.



Status Bar
This area displays information about Agent such as the online status (online or offline), the current task, 
and the number of queued tasks.



Zoom Button
Press this button to maximize the Group, Article, or Body pane.    To restore the window back to showing 
all three panes, press the button that looks like this .



Subscribed Group Icon
This icon appears next to subscribed groups.    To switch between subscribing and unsubscribing to a 
group, select Subscribe from the Group menu.    To view only your subscribed groups, select Show Only 
Subscribed Groups from the Group menu.



New Group Icon
This icon appears next to new groups.    To get the list of groups that have been added to your news 
server since the last time you retrieved groups, select Get New Groups from the Online menu.



Follow Up Articles
These articles are responses to the one above them.    Since follow ups have the same subject as their 
parent, only the author is shown.



Binary Attachment Icon
This icon tells you that the article contains a binary attachment that has already been decoded.    Double-
click the article to view the attachment.



Article with Attachment
This article contains a binary attachment.    To decode an attachment, choose Launch Binary Attachments 
from the File menu.



Groups
These are the Usenet newsgroups.    To retrieve article headers in a group, select the group and choose 
Get New Article Headers in Selected Groups from the Online menu.



Thread
A thread is a series of related articles grouped together.    For example, when people post responses to a 
question, the question and all responses together are called a thread.



Follow Up Article
A follow up article is a response to another posting.    Follow ups generally have the same subject as the 
original and appear indented below it.



How to Post Articles
Reading newsgroups wouldn’t be much fun if you couldn’t contribute as well.    Fortunately, posting 
articles with Agent is just as easy as reading them.

1. Select the group you wish to post to.
A group is selected when it is highlighted in the Group pane or when you are viewing articles for it in 
the Article pane.    

2. (Optional) Select the article you are responding to.
If your article is a follow up to another posting, select that article first so that your posting is properly 
formatted.

3. Open a new Posting window.
From the Post menu, choose New Article or Follow Up Article, depending on the type of posting you 
want.

4. Fill in the Posting window’s fields.
If you selected a group (and article) before opening the Posting window, most of the fields should be 
filled in for you.    When posting a follow up article, it is common practice on the Internet to send a 
copy of your response via email to the original article’s author.    To do this, simply select the author’s 
email address from the Email To list.    If you want to override the default signature, press the All 
Fields button and select the desired signature in the Signature list.    For more information filling in this
window, see the Compose Article window topic.

5. (Optional) Attach a file.
If you want to attach a file to the new article, enter the file name next to the Attachment button or 
press the Attachment button to browse for the file.    For more information on attaching files, see How 
to Send a Binary Attachment.

6. Send the article.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message.

See Also:
Making Sure Articles and Emails Were Sent Properly
How to Send Email
Article and Email Fields
Spelling dialog box
About Agent’s Dictionaries.
ROT13 Encoding and Decoding



How to Send Email
With Agent, sending email to people is a snap and sending email replies to articles is even easier.

1. (Optional) Select the article you are responding to or forwarding.
If you’re replying to or forwarding a posting, select that article first so that your email is properly 
formatted.

2. Open a new Posting window.
From the Post menu, choose New Email, Reply via Email, or Forward via Email depending on the 
type of email you want to send.

4. Fill in the Posting window’s fields.
If you selected Reply via Email, the required fields should be filled in for you.    Otherwise, fill in at 
least the To and Subject fields.    Press the All Fields button to send “carbon copies” to other people, 
select a different signature, or define other information associated with the message.    For more 
information filling in this window, see the Compose Email window topic.

5. (Optional) Attach a file.
If you want to attach a file to the email, enter the file name next to the Attachment button or press the 
Attachment button to browse for the file.    For more information on attaching files, see How to Send a 
Binary Attachment.

6. Send the email.
If you use Agent on line, press Send Now to immediately transmit your message to the Internet.

If you use Agent off line and you have other messages you want to send, press Send Later.    Once 
you have composed all your messages, select Post Articles and Emails from the Online menu to 
transmit them to the Internet.
Send Later Note: Agent does not make copies of attached files prior to sending them.    If you attach 
a file and press Send Later, make sure that the file stays around until you transmit the message.

See Also:
Making Sure Articles and Emails Were Sent Properly
How to Post Articles
Article and Email Fields
Spelling dialog box
About Agent’s Dictionaries.
ROT13 Encoding and Decoding



Making Sure Articles and Emails Were Sent Properly
When you first start using a new program, you probably want to make sure it’s doing what you told it to 
do.    To make sure your articles and emails have been successfully sent, choose Open Outbox from the 
Window menu.    By default, all the articles and emails you send with Agent appear in this window (see the
Message Posting tab of the Preferences dialog box for details).    The icons next to each message tell you
the status of that message:

Icon Meaning
The message was successfully sent.
A problem occurred sending this message.    Double-click on the message to make sure all the 

fields are filled in correctly and then press Send Now or Send Later to re-send the message.
The message is queued for uploading (you pressed the Send Later button after creating the 

message).    To send the message now, choose Post Articles and Emails from the Online menu.
The message is in the process of being sent.



Watching and Ignoring Threads
As you probably already know, some groups on the Internet are very active.    There can be several 
hundred new postings a day.    To help you cut through some of this noise, Agent provides you with two 
very powerful yet very simple features: Watching threads and Ignoring threads.

Watching Threads
When you’re browsing though article headers and come upon one that you know you’ll be interested 
in responses to, select Watch Thread from the Article menu or press “W.”    The Watch Thread icon, 
, will appear next to the article.    Agent automatically retrieves the bodies of all responses to watched 
threads when retrieving article headers.

Note: When you watch a thread with unretrieved articles, Agent automatically marks all the unretrieved 
articles in the thread for retrieval and, if the selected article is unretrieved, skips to the next unread article 
(outside of the current thread).    To retrieve the marked articles, select Get Marked Article Bodies from the
Online menu (for details, see How to Use Agent as an Offline Newsreader).    To keep Agent from skipping
to the next unread article, uncheck the “Watching an unread article skips to the next unread article” box 
on the Navigation tab of the Preferences dialog box.
Ignoring Threads

The opposite of watching threads is ignoring threads.    When you run across an article that you know 
you won’t be interested in responses to, select Ignore Thread from the Article menu or press “I.”    The 
Ignore Thread icon, , will appear next to all the articles in the thread.    Agent automatically marks 
the article and any responses to it, even those retrieved in later sessions, read.    This can significantly
reduce the number of new, unread articles presented to you each time you get new article headers.

Note:    After you ignore a thread, Agent automatically skips to the next unread article.    To turn this 
behavior off (keep the focus on the current article), uncheck the “Watching an unread article skips to the 
next unread article” box on the Navigation tab of the Preferences dialog box.
See Also:
Navigating in Agent
Marking Articles Read



Compose Article window (Post menu)
Use this window to create an article to post in a newsgroup.    For more information, see How to Post 
Articles

Newsgroups
Enter the name of the newsgroup you wish to post to.    To post the same article on multiple groups 
(cross-post), enter the names of all the groups separated by commas (e.g., alt.usenet.offline-
reader,alt.winsock).

Subject
Enter a brief phrase describing the article.

Email To
(Optional) Enter the email addresses of people you wish to send copies of your posting to.    If you are
posting a follow-up article and want to email a copy of your posting to the original article’s author, 
select his/her email address from the drop-down list.    To send an email to more than one person, 
enter all the email addresses separated by commas (e.g., 
john.doe@forteinc.com,jane.doe@forteinc.com).
Note: If you usually copy the original article’s author when posting follow-ups, check the “Copy follow-
up articles to author via email” box on the Posting tab of the Default Properties for All Groups dialog 
box to initialize this field accordingly.

Attachment
(Optional) Enter the name of the file to attach to the article or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show and change the other fields that apply to the article.    Press this button 
again to hide the extra fields.

Fields
This is a list of all the fields that apply to the article.    See Article and Email Fields for a description of 
each field.    To change a particular field’s value, highlight the field and enter the value in the “Value for
<Field>“ control below.    If a field has “Default” next to it, it’s using the default value defined on the 
Posting tab of the Properties for Selected Groups dialog box.

Value for <Field>
the desired value for the field selected above.    If you change a field’s value and later decide to revert 
back to its default value, check the Use Default box to the right of this control.

Signature
Select the signature to place at the bottom of this article.    Choose [None] if you don't want a 
signature added to the article.    You can view, modify, or create signatures with the Signatures dialog 
box.    You can also define a different default signature for each group with the Posting tab of the 
Properties for Selected Groups dialog box.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the Newsgroups field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the Newsgroups field is blank.

Once you have composed all your messages, select Post Articles and Emails from the Online menu 
to transmit them to the Internet.    Note: Agent does not make a copy of the attached file prior to 
sending it.    If you press Send Later, make sure that the file stays around until you transmit the 
message.

Save
Press this button to save your article without sending it.    The article will appear in your Outbox.    To 



view your Outbox, choose Open Outbox Window from the Window menu.    You can double-click the 
article in the Outbox to edit and/or send it.

See Also:
How to Send Email
Making Sure Articles and Emails Were Sent Properly
Message Text Display Options
Spelling dialog box
About Agent’s Dictionaries.
ROT13 Encoding and Decoding



Compose Email window (Post menu)
Use this window to create an email.    For more information, see How to Send Email

To
Enter the recipient’s email address.    To send the same email to more than one person, enter all the 
email addresses separated by commas (e.g., 
john.doe@forteinc.com,jane.doe@forteinc.com).

Subject
Enter a brief phrase describing the email.

Attachment
(Optional) Enter the name of the file to attach to the email or press the Attachment button to browse 
for the file.    For more information, see How to Send a Binary Attachment.

All Fields
Press this button to show the other fields that apply to the email.    Press this button again to hide the 
extra fields.

Fields
This is a list of all the fields that apply to the message.    See Article and Email Fields for a description 
of each field.    To change a particular field’s value, highlight the field and enter the value in the “Value 
for <Field>“ control below.    If a field has “Default” next to it, it’s using the default value defined on the 
Posting tab of the Default Properties for All Groups dialog box.

Value for <Field>
Enter the desired value for the field selected above.    If you change a field’s value and later decide to 
revert back to its default value, check the Use Default box to the right of this control.

Signature
Select the signature to place at the bottom of this article.    Choose [None] if you don't want a 
signature added to the article.    You can view, modify, or create signatures with the Signatures dialog 
box.

Send Now
Press this button to immediately transmit your message to the Internet.    This button appears dim 
when the To field is blank.

Send Later
Press this button if you use Agent off line and you have other messages you want to send.    This 
button appears dim when the To field is blank.

Once you have composed all your messages, select Post Articles and Emails from the Online menu 
to transmit them to the Internet.    Note: Agent does not make a copy of the attached file prior to 
sending it.    If you press Send Later, make sure that the file stays around until you transmit the 
message.

Save
Press this button to save your email without sending it.    The message will appear in your Outbox.    
To view your Outbox, choose Open Outbox Window from the Window menu.    You can double-click 
the message in the Outbox to edit and/or send it.

See Also:
How to Post Articles
Making Sure Articles and Emails Were Sent Properly
Message Text Display Options
Spelling dialog box
About Agent’s Dictionaries.
ROT13 Encoding and Decoding



Article and Email Fields
The following table describes the various fields available to you when composing an article or email.

Field Description
Bcc A list of email addresses (separated by commas) of people to receive a copy of the 

message without the primary recipients (the ones listed in the To and Cc fields) 
knowledge.    If you enter a value for this field when posting an article, it will cause Agent 
to also post an email message to the specified recipients. 

Cc A list of email addresses (separated by commas) of people to receive a copy of the 
message.    If you enter a value for this field when posting an article, it will cause Agent to 
also post an email message to the specified recipients.

Distribution (News only) This field is used to alter the distribution scope of the message.    It is a 
comma separated list similar to the "Newsgroups" field.    User subscriptions are still 
controlled by "Newsgroups", but the message is sent to all systems subscribing to the 
newsgroups on the "Distribution" line in addition to the "Newsgroups" field.    For the 
message to be transmitted, the receiving site must normally receive one of the specified 
newsgroups AND must receive one of the specified distributions.    Thus, a message 
concerning a car for sale in New Jersey might have headers including:

Newsgroups: rec.auto,misc.forsale
Distribution: nj,ny

so that it would only go to persons subscribing to rec.auto or misc. for sale within New 
Jersey or New York.    The intent of this header is to restrict the distribution of a 
newsgroup further, not to increase it.    A local newsgroup, such as nj.crazy-eddie, will 
probably not be propagated by hosts outside New Jersey that do not show such a 
newsgroup as valid.    A follow-up message should default to the same "Distribution" line 
as the original message, but the user can change it to a more limited one, or escalate the 
distribution if it was originally restricted and a more widely distributed reply is appropriate.

Expires (News only) The date you want the article to expire. 

Followup-To (News only) The newsgroups where you want follow-up articles posted. 

From The email address and optional full name of the person who posted the article or sent the
email. 

Keywords Optional keywords to help categorize the article or email message. 

Organization (News only) Your organization, company, school, etc. 

Reply-To The email address where you want replies sent.    If you normally want replies sent to 
your From email address, you can leave this field blank. 

Sender The name of the entity responsible for submitting the article or email message to the 
network.    Normally, this field is blank, to indicate that the From field also names the 
submitting entity.    For example, if Rennie Mitchell is visiting George Mitchell and wishes 
to use his computer to post an email message, George would temporarily set his Sender 
field to his own email address and set the From field to Rennie's email address.    This 
indicates that the messages are being submitted by George on Rennie's behalf. 

Summary (News only) An optional summary description of the article. 

See Also:
Compose Article window
Compose Email window
How to Post Articles
How to Send Email



ROT13 Encoding and Decoding
Some Internet messages contain text encoded with a scheme called ROT13.    ROT13 encoded text 
cannot be read without first decoding it.    For example, “Hello World” encoded with ROT13 looks like this: 
Uryyb Jbeyq

To decode a ROT13 message:
Select the encoded text and choose Apply ROT13 from the Edit menu or press Ctrl+R.

To encode a ROT13 message:
Select the text to encode and choose Apply ROT13 from the Edit menu or press Ctrl+R.

Note: When you decode text in an article you have retrieved, the decoding only affects your display.    If 
you come back to this article later, you will again see the original, encoded text.    Encoding text in a 
message you're creating, on the other hand, affects the actual text.    If you then post the message, other 
people will see it with the text encoded. 

See Also:
How to Post Articles
How to Send Email



Copying a WWW URL to the Clipboard
Many Internet messages contain addresses of World Wide Web (WWW) pages.    Although Agent doesn’t 
directly support Web browsing, it makes it easy for you to copy these addresses, called URLs, to the 
Windows Clipboard for pasting into another program like Mosaic or Netscape.

To copy a WWW URL to the Clipboard:
While viewing an article with a URL, choose Copy WWW URL from the Edit menu or press Ctrl+U.    
Agent will scan the article starting at the cursor’s current location, highlight the first URL it finds, and 
copy it to the Clipboard.    To search for another URL, simply press Ctrl+U again.    If Agent can’t find 
the URL, you may need to customize the URLPattern setting in AGENT.INI.

To paste a WWW URL into Mosaic:
Launch Mosaic and choose Open URL from its File menu.    Click in the URL field and press Ctrl+V.

To paste a WWW URL into Netscape:
Launch Netscape and choose Open Location from its File menu.    Click in the edit field and press 
Ctrl+V.



Common Internet Acronyms
<BG> Big Grin
<g> Grin
BRB Be right back
BTW By the way
CP Copy protection
FUBAR Fouled up beyond all recognition (or 

repair)
FWIW For what it's worth
FYI For your information
GD&WVVF Grinning, ducking, and walking very, very

fast
GR&D Grinning, running, and ducking
IAE In any event
IANAL I am not a Lawyer
IMHO In my humble opinion
IMO In my opinion
IOW In other words
LOL Laughed out loud
LZ Loser!
OIC Oh, I see
OTOH On the other hand
PITA Pain in the Ass
PMJI Pardon my jumping in
PMFJI Pardon me for jumping in
ROFL Rolling on floor, laughing
ROTFL Rolling on the floor laughing
ROTFLMAO Rolling on the floor laughing my ass off
RSN Real soon now
RTFM Read the f@%# manual (or message)
SNAFU Situation normal, all fouled up
TIA Thanks in advance
TPTB The powers that be
TTFN Ta ta for now

How to Get All the Article Bodies in a Group
Agent provides you with two ways to retrieve the bodies of all the articles in a group:

To always retrieve all the bodies in a particular group:
1. Select the group(s) for which you want to retrieve bodies.
2. Choose Properties for Selected Groups from the Group menu.
3. Select the Retrieving tab on the Properties for Selected Groups dialog box.
4. Make sure the “Override default settings” box is checked.
5. Check the “Retrieve bodies for all new articles” box.

To retrieve all the bodies in a group on an ad-hoc basis:
1. Select any article in the Article Pane of the group for which you want to retrieve bodies.
2. Choose Select All from the Edit menu or press Ctrl+A.
3. If you are online, choose Get Selected Article Bodies from the Online menu.    If you are offline, 

choose Mark for Retrieval from the Article menu.    You can later retrieve the marked articles by 
selecting Get Marked Article Bodies from the Online menu.

See Also:
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader
Online Menu Commands Explained





How to configure a GIF or JPG viewer to work with Agent
The Internet contains a wide variety of graphic images which are usually stored in GIF or JPG formatted 
files.    Although Agent doesn’t display these images directly, you can view them from Agent if you have a 
GIF or JPG viewing program like LVIEW.    To configure your system for viewing graphics from Agent:

1. Run File Manager.
From Program Manager, double-click the File Manager icon.

2. Open the Associate dialog box.
Choose Associate from File Manager’s File menu.

3. Create an association.
In the Associate dialog box, enter GIF or JPG into the Files with Extension box.    Enter the full path of 
your graphics viewer into the Associate With box or press Browse to search for the viewer on your 
hard drive.

See Also:
How to Retrieve a Binary Attachment



How to Use Agent as an Offline Newsreader
If you pay an hourly rate for your Internet connection, an Offline newsreader can save you lots of money 
by minimizing the time you are connected to your service provider.    To use Agent as an offline reader, 
follow the steps below:

1. Make sure you are configured for offline operation.
Choose Preferences from the Options menu and select the Online Operation tab.    Press the Use 
Offline Defaults button and Agent will automatically configure itself for offline use.

2. Get headers for new articles.
To retrieve the headers of all the new articles in all your subscribed groups, choose Get New Headers
in Subscribed Groups from the Online menu.    If you only want the new headers in a particular group, 
select that group and choose Get New Headers in Selected Groups from the Online menu.

Agent will now go online and retrieve the new headers.    As soon as it is done, it will go offline so that you 
are no longer incurring connect charges.

All the article headers Agent retrieved will be colored red (assuming you’re using Agent’s default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the article is new, or “unread.”

3. Mark articles for retrieval.
Browse through the article headers just retrieved and look for ones that interest you.    When you find 
one, highlight it and do any one of the following:

· Click the Mark for Retrieval toolbar icon 
· Choose Mark for Retrieval from the Article menu
· Press the M or Enter key

· Double-click on the article

Repeat the above step for each article whose body you wish to retrieve.

4. Get marked article bodies.
Once you’ve marked all the interesting articles in all your groups, choose Get Marked Article Bodies 
from the Online menu.

Agent will now go online to retrieve the full text of all your marked articles and go offline as soon as it’s 
done.

5. Read the retrieved articles.
Any articles you did not mark in the previous step will automatically have been marked read when you
retrieved marked article bodies in the previous step (see Marking Articles Read for details).    You can 
now use the options on the Navigate menu to quickly find and read the articles you just retrieved.

See Also:
Navigating in Agent
How to Use Agent as an Online Newsreader
About Article Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



How to Use Agent as an Online Newsreader
If you don’t pay an hourly rate for your Internet connection, you probably want to remain connected to 
your service provider while using Agent.    To use Agent as an online reader, follow the steps below:

1. Make sure you are configured for online operation.
Choose Preferences from the Options menu and select the Online Operation tab.    Press the Use 
Online Defaults button and Agent will automatically configure itself to stay online.

2. Get headers for new articles.
To retrieve the headers of all the new articles in all your subscribed groups, choose Get New Headers
in Subscribed Groups from the Online menu.    If you only want the new headers in a particular group, 
select that group and choose Get New Headers in Selected Groups from the Online menu.    

Agent will now go online if you’re not currently connected to the news server.    It will remain online until 
you manually go offline (by exiting the program or deselecting Online from the Online menu) or it detects 
an extended period of inactivity.

All the article headers Agent retrieved will be colored red (assuming you’re using Agent’s default color 
scheme - see the Preferences dialog box, Colors Tab).    This signifies that the article is new, or “unread” 
(see Marking Articles Read for more information).

3. Read articles.
To read an article, select it and choose View Selected Article from the Navigate menu.    You can also 
read an article by simply double-clicking on it or highlighting it and pressing Enter.    To read the next 
unread article, use the View Next Unread Article (Ctrl+N) or View Next Unread Article in Thread 
(Ctrl+T) commands on the Navigate menu.    These commands jump to the next unread article and 
retrieve its body at the same time.

See Also:
Navigating in Agent
How to Use Agent as an Offline Newsreader
About Article Purging
Online Menu Commands Explained
Watching and Ignoring Threads
Properties for Selected Groups dialog box, Retrieving tab



Article Header
A brief description of an article.    An article’s header contains key information about the article, such as its 
author and subject, but does not include the text, or “body,” of the article itself.



Article Body
The actual text of an article.    The other components of an article, such as its subject, author, etc., are 
called the article’s “header.”



Marking Articles Read
New articles you retrieve are initially marked unread.    When you view the article’s body, Agent then 
marks that article read.    Since you probably don’t read all the articles whose headers you retrieve, Agent 
automatically marks the articles you don’t care about as read.

To control when Agent automatically marks articles read:
By default, Agent automatically marks unwanted articles read whenever you retrieve article headers 
or bodies.    This makes it easy for you to find the new articles because they will be the only ones 
which are unread.    To change this behavior, choose Properties for Selected Groups from the Group 
menu and select the Marking Read tab.

To manually mark articles read:
Select the articles you want to mark read and choose Mark Article Read from the Article menu.    To 
mark all the articles in a group read, select the group and choose Mark Selected Groups Read from 
the Group menu or Mark All Articles Read from the Article menu (these two commands are 
equivalent).    To mark all the articles in all your groups read, choose Mark All Groups Read from the 
Group menu.

To manually mark an article unread:
Select the articles you want to mark unread and choose Mark Article Unread from the Article menu.    
To mark all the articles in a group unread, select the group and choose Mark All Articles Unread from 
the Article menu.

See Also:
Watching and Ignoring Threads



About Article Purging
In general, Agent automatically deletes, or “purges,” old articles for you.

When does Agent purge articles:
There are three times when articles can be purged:

· When retrieving new headers

Agent can purge a group’s old articles whenever it retrieves new article headers for that group.    
To turn this feature on, check the “When retrieving new headers” box on the When to Purge tab of
the Default Properties for All Groups dialog box.

· When closing Agent

Agent can purge old articles from all groups when exited.    To enable this option, check the 
“When closing Agent” box in the When to Purge group on the When to Purge tab of the Default 
Properties for All Groups dialog box.

· On demand

You can manually purge old articles by selecting one of the options from the Purge Articles flyout 
on the Group menu.    Or, to immediately delete an article without purging the other articles in the 
group, select the article and, from the Article menu, choose either Delete Article (to remove the 
entire article) or Delete Article Body (to remove the article’s text while continuing to display its 
header in the Article pane).    A message will appear asking you to confirm the delete action.    To 
turn off the delete confirmation message, see the Confirmations tab of the Preferences dialog 
box.

Which articles does Agent purge:
Agent provides you many options when deciding which articles to automatically purge.    You can 
purge articles once you’ve read them or after a certain period of time.    You can even setup Agent to 
mirror your news server - so you’ll only see articles that are available for retrieval.    To define which 
articles get purged, see the What to Purge tab of the Properties for Selected Groups dialog box.

How to prevent Agent from purging an article:
Occasionally you will come across an article that you don’t want Agent to automatically purge.    To 
prevent Agent from deleting an article, regardless of the group’s purge settings, highlight the article 
and choose Keep Article from the Article menu or press the Keep Article toolbar button .    The 
Keep Article icon, 

, will appear next to the article.    To remove the Keep Article icon, choose the Keep Article command 
again.
Note: When the Keep Article icon appears next to an article, you cannot manually delete the article or its 
body.    You must remove the Keep Article icon first.
See Also:
Compacting Agent’s Database Files



Purge Articles Flyout
Subscribed Groups - Purges articles from all your subscribed groups.
Selected Groups - Purges articles from the current group or highlighted groups.
All Groups - Purges articles from all your groups.



Compacting Agent’s Database Files
So that Agent can work quickly and efficiently, it does not always ensure that its database files are as 
small as possible.    If disk space is at a premium, there are two ways that you can compact your 
databases to remove the wasted space that may accumulate.

To manually compact the database files:
Choose Compact Databases from the File menu.    Agent will scan the databases to determine how 
much disk space you will save.    After the scan is complete, you may choose to either proceed with 
the compaction or cancel without affecting any files.

To automatically compact the database files:
You define when Agent should automatically compact your databases with the When to Purge tab of 
the Default Properties for All Groups dialog box.    In general, you probably don’t need to compact 
your databases automatically.    Compacting after you change your purge settings should be sufficient 
for most people.

See Also:
About Article Purging



Navigating in Agent
Agent provides you with a rich set of tools for moving between newsgroups and articles.    Most of these 
tools can be accessed from the Navigate menu, the toolbar, and the keyboard.    Although you probably 
won’t use all the available options, this topic will make you familiar with them so that you can choose 
which navigation techniques best suit you.

Moving between panes
As you probably already know, Agent is composed of three panes: the Group pane, the Article pane, and 
the Body pane.    You can view all three panes at the same time, or, to maximize the information you see 
on-screen, Zoom the newsgroup window to expand the current pane to fill Agent’s window.

To Zoom a newsgroup window:
· Select Zoom Window from the Navigate menu
· Press “Z”
· Click the Maximize icon  in the pane you wish to expand.

To view all three panes at the same time (turn Zoom off):
· Select Zoom Window from the Navigate menu
· Press “Z”
· Click the Restore icon .

You can easily move the focus between the panes with both the mouse and the keyboard.

To move between panes with the mouse:
· When viewing all three panes, simply click on the desired pane.
· When zoomed in on a pane, click the tab for the pane you wish to view:

To move between panes with the keyboard:
· Press the Tab key to move from the Group pane to the Article pane to the Body pane.
· Press Shift+Tab or Escape to move in the reverse order.

Moving between articles
Moving between articles is probably the single most common action you perform in Agent.    That’s why 
Agent provides you so many different ways to do this.

To move to the previous or next article:
· From the Article pane, you can use the up and down arrow keys to move between articles.
· From the Body pane, choose Up to Previous Article (or press “U”) or Down to Next Article (or 

press “D”) from the Navigate menu.    Note: These commands also work in the Article pane.

To move to the next unread article:
· Press “N” or the Skip to Next Unread Article toolbar icon  to skip to the next unread article.    By

default, if the next unread article is in a different group, skipping to the next unread article causes 
Agent to open that group and select the first unread article.    If you would prefer Agent to move 
you to the Group pane instead (so that you can more easily tell when you’re done with a group), 
uncheck the “Skipping to next unread article jumps to first unread article in next group” box on the
Navigation tab of the Preferences dialog box.

· Press “T” or the Skip to Next Unread Article in Thread toolbar icon  to skip to the next unread 
article in the current thread.    This action is handy because when you reach the last follow-up article, 
Agent stops navigating, telling you that the thread is over.

· Press “S” or the Skip to Next Unread Group toolbar icon  to skip to the first unread article in 
the next group.    By default, this action marks all the unread articles in the current group as read 
before skipping to the next group.    This is a convenient way to tell Agent that you have read all 
the interesting articles in the current group.    You can disable this behavior by unchecking the 
“Skipping to next unread group marks all articles in current group read” box on the Navigation tab 
of the Preferences dialog box.



Navigating and retrieving articles at the same time
Since you need to retrieve an article before you can read it, Agent allows you to skip to an unread article 
and retrieve it (or mark it for retrieval) in one step.    Note: Whether Agent retrieves the article or marks it 
for later retrieval is controlled by the Viewing Unretrieved Articles When Offline radio buttons on the 
Online Operation tab of the Preferences dialog box.

To retrieve the next unread article:
· Press Ctrl+N or the View Next Unread Article toolbar icon  to skip to the next unread article 

and retrieve it (or mark it for retrieval).    Note: The action is controlled by the same preference 
settings affecting “N” (see above).

· Press Ctrl+T or the View Next Unread Article in Thread toolbar icon  to skip to the next unread 
article in the current thread and retrieve it (or mark it for retrieval).

When configured for offline use (see the Online Operation tab of the Preferences dialog box for details), 
you generally mark all the desired articles for retrieval and then retrieve marked article bodies.    By 
default, Agent skips to the next unread article (performs the “N” action) when you mark an article for 
retrieval.    You can turn this behavior off by unchecking the “Marking or ignoring an article skips to the 
next unread article” box on the Navigation tab of the Preferences dialog box.

Expanding and collapsing threads
Agent displays follow-up articles indented under the original article.    To save screen real-estate, these 
threads are initially shown collapsed, so only the top-most article is visible.    When a thread is collapsed, 
the Expand Thread icon  appears next to it.

To expand a thread:
· Click the Expand Thread icon.
· Select the article and press the “+” key.
· To expand all the threads in a group, hold down the Shift key while pressing the “+” key. 

When a thread is expanded, the Collapse Thread icon  appears next to it.

To collapse a thread:
· Click the Collapse Thread icon.
· Select the article and press the “-” key.
· To collapse all the threads in a group, hold down the Shift key while pressing the “-” key. 

Agent can also automatically expand threads for you.    By default, Agent expands threads when you skip 
to them.    Note: Agent will automatically expand the thread when skip to it only if you have already 
retrieved the body of the original article.    To prevent Agent from expanding threads when you skip to 
them, uncheck the “Automatically expand threads containing new articles” box on the Navigation tab of 
the Preferences dialog box.    If you always want all threads expanded, uncheck the “Show threads initially
collapsed” box on the Navigation tab of the Preferences dialog box.

See Also:
Watching and Ignoring Threads
How to Use Agent as an Offline Newsreader
How to Use Agent as an Online Newsreader
Online Menu Commands Explained



Printing Articles
Agent allows you to print one or more articles in a single group with one command.

To print articles:
1. Define how you want the printed articles to appear (margins, fonts, etc.) with the Page Setup dialog 

box.

2. Select all the articles to print.    If you select a collapsed thread, Agent will print all articles in the 
thread.    Agent only prints articles whose bodies have been retrieved. 

3. Choose Print from the File menu.    Press OK on the Print dialog box to start printing the articles. 

See Also:
Save Article As dialog box



Finding Groups or Articles
Agent allows you to search for groups by the name of the group and for articles by the article’s subject or 
author.

To find a group:
1. Make sure the focus is in the Group pane.    Note: You can do this by selecting any group in the Group

pane.

2. Choose Show All Groups from the Group menu.

3. Choose Find from the Edit menu. 

4. Enter any part of the desired group’s name in the Find dialog box.    For example, if you enter win into
the Find dialog box, Agent will find, among others, alt.winsock, alt.sewing, and 
rec.crafts.winemaking. 

5. Press Find First to find the first group in the Group pane with this text in its name.    Press Find Next to
find the first group below the currently selected one with this text in its name. 

6. If the found group isn’t the one you were looking for, press F3 or choose Find Next from the Edit 
menu to search for the next group with the text you entered. 

To find an article:
1. Make sure the focus is in the Article pane of the group you want to search.    Note: You can do this by 

selecting any article in desired group.

2. Choose Find from the Edit menu. 

3. Enter any part of the desired subject or name in the Find dialog box. 

4. Press Find First to find the first article whose subject or author contains the text you entered.    Press 
Find Next to find the first article below the currently selected one with this text in the subject or author 
fields. 

5. If the found article isn’t the one you were looking for, press F3 or choose Find Next from the Edit 
menu to search for the next article in this group that contains the text you entered.



How Agent Knows Which Articles are New
When you select either Get New Headers in Subscribed Groups or Get New Headers in Selected Groups,
Agent only retrieves the articles that have been posted to the groups since the last time you checked for 
new articles.    

How does Agent know which articles are new and which ones you’ve previously retrieved?    Every time 
an article is posted to a group, the news server assigns it a number that is one higher than the last article 
posted to that group.    Each time you retrieve headers for a group, Agent keeps track of the highest article
number retrieved.    This number is stored in the “Highest article retrieved” field on the Retrieving tab of 
the Properties for Selected Groups dialog box.    The next time you tell Agent to retrieve new headers for a
group, it will retrieve only the headers of articles whose number is greater than the “Highest article 
retrieved” value.

You can reset the high article number by selecting the desired group and choosing Catch Up With 
Selected Groups from the Online menu.    This causes Agent to connect with the news server and query it 
for the highest article number without retrieving any new headers.

See Also:
Online Menu Commands Explained



Online Menu Commands Explained
The Online menu contains the commands which cause Agent to interact with the Internet.    This topic 
describes these actions in detail and provides links to related Help topics.

Get New Headers in Subscribed Groups 
Retrieves all the article headers that have been posted to your subscribed groups since the last time 
you checked for new articles.    By default, Agent marks a group’s existing articles read before it 
retrieves new headers for that group.    To change this behavior for all your groups, uncheck the “New 
article headers” box on the Marking Read tab of the Default Properties for All Groups dialog box.

Get New Headers in Selected Groups 
Retrieves all the article headers that have been posted to the selected groups since the last time you 
checked for new articles.    By default, Agent marks a group’s existing articles read before it retrieves 
new headers for that group.    To change this behavior for a particular group, select that group and 
uncheck the “New article headers” box on the Marking Read tab of the Properties for Selected 
Groups dialog box.

See Also:
How Agent Knows Which Articles are New
How to Get All the Article Bodies in a Group
Marking Articles Read
Retrieving tab of the Default Properties for All Groups dialog box

Get Marked Article Bodies 
Retrieves the bodies of all the articles you marked for retrieval.    Articles from all groups with marked 
articles are retrieved with this command (not just ones from the selected group).    Also, by default, 
articles that were not marked for retrieval are made read when Agent retrieves marked article bodies 
for that group. To change this behavior, uncheck the “Marked article bodies” box on the Marking Read
tab of the Default Properties for All Groups dialog box.

See Also:
How to Use Agent as an Offline Newsreader

Get Selected Article Bodies 
Retrieves the full text of the selected article(s).    You can also retrieve an article’s body by double-
clicking on the article or by highlighting it and pressing Enter.    Note: Even if you are configured for 
offline use (see the Online Operation tab of the Preferences dialog box for details), selecting this 
menu command causes Agent to go online and retrieve the selected articles.

See Also:
How to Use Agent as an Online Newsreader

Sample 50 Headers from Selected Groups
Retrieves article headers for the 50 most recently posted articles in the selected groups.    This 
command is useful when you are looking at new groups and don’t want to get stuck retrieving 
hundreds of headers for a group you may not be interested in.    Note: You can change the number of 
articles retrieved when you sample a group with the Retrieving tab of the Default Properties for All 
Groups dialog box.

If, after sampling some of the headers, you decide that you are interested in the group, choose Get All
Headers in Selected Groups to retrieve the remaining articles.

See Also:
View Empty Group dialog box

Get All Headers in Selected Groups
Retrieves article headers for every article in the selected groups.    In general, you should use one of 



the Get New Headers commands to retrieve articles because they retrieve only the articles you 
haven’t seen.    This command is useful, however, after you’ve sampled some headers from a group 
and want to retrieve the remaining ones.    You can also use this command to retrieve articles that you
manually deleted or that were automatically purged.

See Also:
About Article Purging

Catch Up With Selected Groups
Retrieves the highest article number for the selected groups without retrieving any article headers.    
The next time you get new headers for the groups, Agent will only retrieve articles posted after you 
did the catch up.

Note: Some other newsreaders employ a slightly different implementation of catch up.    When you 
“catch up” in those programs, they do not retrieve the highest article number.    Instead, they simply 
mark read the articles you previously retrieved.    You can achieve the same behavior in Agent with the
Mark Selected Groups Read command on the Group menu.

See Also:
Marking Articles Read

Post Articles and Emails
Transfers any queued articles and emails to the Internet.

See Also:
How to Post Articles
How to Send Email
Making Sure Articles and Emails Were Sent Properly

Get New Groups
Retrieves all the newsgroups which were added to your news server since that last time you updated 
your group list.    The new groups Agent retrieves will have the New Group icon, , next to them until 
the next time you get new groups.    To view just the new groups, choose Show Only New Groups 
from the Group menu.    Note: On rare occasions, a group may be added to your news server in such 
a way that Get New Groups will not retrieve it.    For this reason, you may want to periodically use the 
Refresh Groups List action instead.

Refresh Groups List
Retrieves a complete list of groups from the news server.    Use this command when you want to 
recover a group you previously deleted or when you want to purge groups that are no longer available
on the news server.

See Also:
Refresh Groups List dialog box

Stop All Tasks 
Causes Agent to immediately abort the current and any pending online tasks.

Online 
Toggles Agent’s Online status.    When this menu option is checked (the toolbar button appears 
illuminated), Agent is online and selecting it will take Agent offline.    When this menu option does not 
have a checkmark next to it (the toolbar button appears as above), Agent is offline and selecting it will
cause Agent to connect to your service provider.    You can also press the toolbar button to toggle 
Agent’s online status.



Delete Group command (Group menu)
Use this command to remove a group from your group list.

To remove a specific group from your group list:
Select the group and choose Delete Group from the Group menu.

To remove all extinct groups from your group list:
Choose Refresh Group List from the Online menu.    On the Refresh Group List dialog box, select the 
“Delete all extinct groups” option.

To recover groups you deleted:
Choose Refresh Group List from the Online menu.



Cancel Article command (Article menu)
Use this command to remove an article you posted.    Canceling an article sends a message to your news 
server asking it to delete the article.    This message is also passed along to the other news servers on the
Internet so that they can delete the article as well.

To cancel an article:
1. Select the article and choose Cancel Article from the Article menu.    You can only cancel your own 

articles.    Note: Cross-posted articles only need to be canceled from one of the cross-posted groups.

2. In the Compose Article window, press Send Now or Send later to transmit the message to your news 
server.    You should not make any other changes to the message. 

After sending the message, the article will continue to appear in Agent until it’s 
automatically pruned or you delete it (see About Article Purging for details).    Since some news 
servers do not accept cancel requests, you may want to verify that the posting was actually 
deleted.
To verify that the article was deleted:
1. Highlight the article you canceled.

2. Delete the article’s body by selecting Delete Article Body from the Article menu. 

3. Try to retrieve the article’s body again by choosing Get Selected Article Bodies from the Online menu. 
If the cancel request was accepted, the Article Body Not Available icon  will appear next to the 
article. 



Message Text Display Options
The following settings control the appearance of message text:

Normal Font
The standard font used to display message text is defined in the Variable-Pitch Body Font dialog box. 

Fixed Pitch Font
You can also display message text in a fixed-pitch font. Many people on the Internet have fancy 
ASCII-graphic signatures.    These signatures will look like a jumble of lines and letters unless they are
displayed in a fixed-pitch font.    To display messages you’ve retrieved in a fixed-pitch font, choose 
Fixed Pitch from the Article menu.    To display messages you’re composing in a fixed-pitch font, 
choose Fixed Pitch from the Compose window’s Message menu.    To return to the standard, variable-
pitch font, select the Fixed Pitch menu option again.    You define which fixed-pitch font you want 
Agent to use in the Fixed-Pitch Body Font dialog box.

Word Wrap Lines
Occasionally you will see messages with very long lines that don’t fit on your screen.    When this 
happens, simply select Word Wrap from the Article menu and Agent will break these lines at the end 
of the window.

Messages you send are automatically word wrapped at the length defined in the Message Posting tab
of the Preferences dialog box.    If your Compose window is narrower than this value, select Word 
Wrap from the Message menu and Agent will wrap your lines when they reach the end of the window. 
Note: This wrapping is for your display only.    When the message is sent, each line is wrapped at the 
value defined in the Preferences dialog box.

Display Header Fields
Usenet articles can have many fields associated with them, only a few of which are important (e.g., 
Subject and Author).    Since you generally don’t care about the remaining fields, Agent hides them 
from.    To see these remaining fields, select Show All Header Fields from the Article menu.    For a 
description of what these fields represent, see Article and Email Fields.

See Also:
Compose Article window
Compose Email window





Spell Checker Not Available
Free Agent does not include a spell checker.    To add a spell checker plus lots of other features to your 
news reader, order Agent today!!







Forté Agent Registration dialog box
This dialog box is displayed the first time you run Agent.    You must enter the registration key you 
received via email into the entry box.    If you have not received your registration key within 24 hours of 
placing your order, please send email to order-question@forteinc.com.

Since registration keys can be very long, you will probably want to copy it from your email program and 
paste it into this dialog box.

To paste the registration key from a standard Windows email program:
1. Highlight the registration key in the email message.    Be sure to highlight the entire key and 

nothing else in the message.
2. Choose Copy from the Edit menu to copy the key to the Clipboard.
3. Run Agent.
4. In this dialog box, click in the entry box and press Ctrl+V to paste the key.



Forté Agent Registration dialog box
This is the shrink-wrapped registration dialog box.



Agent Features
Forté’s commercial newsreader, Agent, includes all the functionality of Free Agent plus the following:

Spell Checker
100,000+ word dictionary with language specific dictionaries available.    Custom dictionary for adding 
your own words.

Folders
Store messages in user-defined folders.

Kill Lists
Automatically ignore articles based on the subject or author. 

Watch Lists
Automatically retrieve articles based on the subject or author. 

Sorting
Display articles and emails in various orders.    E.g., By author or size. 

Filtering
Show only a subset of the messages.    E.g., Show only unread articles. 

Launch URL’s
Automatically run your WWW browser or FTP program when you find an interesting URL (e.g., 
<http://www.forteinc.com/forte/>) in a message. 

Read/Write newsrc Files
Support the use of multiple newsreaders (e.g., one at home and another one at work).    Keeps track 
of which articles have been read by both programs. 

Enhanced cross-post management
Reading a cross-posted article in one group marks it read in all other groups. 

Customizable toolbar
Choose which commands appear on the toolbar. 

Advanced Group Searching
Filter the Group Pane to only show groups with specific text in the group's name. 

International Character Support
Display characters from various languages in messages using the standard MIME format. 

MAPI/VIM Support
Integrate Agent email with the corporate email system. 

Receive Email
Receive email from POP and SMTP mail servers. 

Support for MIME Attachments
Encode and decode attachments using the email standard MIME format. 

Address Book
Keep track of people's email addresses and various other information. 

For more information on Agent’s features, see our home page at 
<http://www.forteinc.com/forte>.    To purchase your own copy of Agent, see Ordering Agent.





Ordering Agent
For a limited time only, Forté is offering a pre-release version of Agent, called Agent .99, to individuals 
who wish to purchase our commercial newsreader product.    Agent .99 includes all the features of Free 
Agent plus a multilingual spelling checker and 6 months of technical support via email.    By purchasing 
Agent .99 now, you will also receive a free upgrade to Agent 1.0 when it’s available.    For more 
information on this special offer, please see our home page at <http://www.forteinc.com/forte>.

You can purchase Agent .99 in any of the following ways:

1. Through the World Wide Web.    This is the fastest and easiest way to get Agent.    Forté’s ordering 
page is on a secure Netscape Commerce Server, ensuring that your confidential information remains 
confidential.    For details on ordering Agent through the Web, please see our home page at 
<http://www.forteinc.com/forte>.

2. If you don’t have convenient Web access, the next best way to order Agent is by fax or mail.    Simply 
print out and complete the Agent Order Form and either fax it to Forté’s Agent Order Desk in 
Carlsbad, California at 619.431.6497 or mail it to:

Agent .99
c/o Forté
2141 Palomar Airport Road
Suite 100
Carlsbad, CA 92009

3. If neither of the above methods are suitable, you can call the Agent Order Hotline at 619.431.6496.    
The Hotline is open from Monday to Friday, 7:30 a.m. - 5:00 p.m. Pacific time.





AGENT.INI
;=====================================================================
[Profile]
FullName=
;Your full name as you want it to appear in your messages.
;You may leave this blank.

EMailAddress=
;Your email address.

ReplyTo=
;Where replies to your messages should be sent,
;if different from your email address.

Organization=
;Your organization.
;You may leave this blank.

DoAuthorization=0
;When non-zero, perform authorization login to news server.

SavePassword=1
;Save authorization password between sessions.

UserName=
;News server authorization username.

Password=
;News server authorization password (encrypted).

IsLicensed=1
;User has accepted the license agreement.

IsRegistered=1
;User has registered Free Agent.

EnableSupportMenu=0
;System administrators for site-based copies of Agent can turn this
;parameter on to display the Post | Support Question menu option.

;=====================================================================
[View]
AutoOpenMode=1
;Automatically maintain positioning in subsidiary browsers when
;the highlight in a browser changes.

ShowToolBar=1
;Display the toolbar at the top of the screen

ShowStatusBar=1
;Display the status bar at the bottom of the screen

StatusBarFont=MS Sans Serif, 80, 0, 0, 0,0,0
;Font used for text in the status bar.

InitialView=1
;Specifies the initial view for the Group Pane:
; 0 - All Groups
; 1 - Subscribed Groups
; 2 - New Groups



MainWindowPosition="0 1 -1 -1 -4 -4 86 57 875 677"
;Initial screen position of the program's main window

BrowserPosition="3 3 94 347 -4 -23 15 18 663 348"
;Initial screen position of the browser

;=====================================================================
[Browser]
NormalFont=Arial, 80, 0,0, 0,0,0
;Font for normal items
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

BoldFont=MS Sans Serif, 80, 1,0, 0,0,0
;Font for special items( e.g. first article in thread)
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

ScrollMargin=2
;The minimum number of lines to maintain above and below the
;highlighted item when scrolling with the cursor keys.  This keeps 
the ;highlight from getting pinned at either the top or bottom screen rows.

FollowUpIndent=4
;Amount to indent follow-up articles in the article list pane,
;in characters.

MaxNestLevel=6
;The maximum indentation level for response articles in the article
;list browser.  The absolute maximum level allowed is 15.

CollapseThreads=1
;Initially collapse threads in the article list pane.

ExpandNewThread=1
;When positioning on a new article, automatically expand the thread
;if the article is a follow-up and if the first article in the thread
;has been retrieved.

SubjectThreading=1
;Use subjects to combine articles into threads, in addition to message
;references.

ArticleListColumns=147,745
;Offsets of the left edges of the columns in the article browser pane,
;in units of 10x the average character width.
;The edge of the left-most column is always 0, so is not included here.

OutBoxColumns=87,432,697
;Offsets of the left edges of the columns in the outbox browser,
;in units of 10x the average character width.
;The edge of the left-most column is always 0, so is not included here.

NewSubjectStartsNewThread=1
;When set, a follow-up article that contains a different subject than
;its referenced article starts a new thread.  When this option is not
;set, Agent includes the follow-up in its referenced article's thread.

SpeedMenuRightButton=0
;When non-zero, the right mouse button selects options from the context
;menu.  When 0 (the default), the left button must be used.

WatchSkipsToNextUnread=1



;When this option is on (the default), watching an unread article
;causes Agent to skip to the next unread article.

;=====================================================================
[Article]
VariableFont=MS Sans Serif, 100, 0,0, 0,0,0
;Variable-pitch font for the article body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

FixedFont=Courier, 100, 0,0, 0,0,0
;Fixed-pitch font for the article body viewer
;<fontname>, <points*10>, <bold>, <italic>, <red>,<green>,<blue>

UseFixedFont=1
;Use the fixed-pitch font for articles

WordWrap=1
;Word wrap articles

ShowHeader=1
;Show all header fields in articles

QuotedTextMarkers=>:|}
;The characters that mark a quoted line of text in an article.
;If a line begins with any of these characters, it is assumed to be
;quoted.

URLPattern=[a-zA-Z]+:/[^ \t\r\n>)\]"']*[a-zA-Z0-9/]
;A regular expression defining the pattern for URLs

TabSpacing=3
;Tab spacing for articles.

SaveArticleFields=2
;Controls which header fields to save when writing an article to a text file
; 0 No fields
; 1 Subject, author, and date only
; 2 All fields

SaveArticleAppend=1
;If the file to which an article being saved already exists, append to
;it.  Otherwise, overwrite the file after prompting for verification.

PageDownMode=0
;Controls the behavior of the PageDown key in the Body Pane.
;When the option is non-zero, Agent will not page down if the last
;line of the article is visible.  The default setting is zero.

;=====================================================================
[Groups]
LastUpdate=
;The most recent date and time at which the program retrieved a list
;of new Usenet groups, in GMT.  When the program retrieves a list of
;new groups, it asks for all groups created after this date.
;
;Setting this to blank forces the program to retrieve a list of all
;groups.

;=====================================================================
[Servers]



NewsServer=
;The name of the NNTP news server

MailServer=
;The name of the SMTP mail server

NNTPPort=119
;Winsock port to use for connecting to the NNTP news server.
;When this value is the standard news server port number (119), Agent
;first asks the winsock driver for the port number to use.  If that
;call (getservbyname) fails, Agent then tries to use this port number.
;When this value is *not* the standard news server port number, Agent
;uses it instead of the asking the winsock driver for the port number
;to use.

SMTPPort=25
;Winsock port to use for connecting to the SMTP mail server.
;When this value is the standard mail server port number (25), Agent
;first asks the winsock driver for the port number to use.  If that
;call (getservbyname) fails, Agent then tries to use this port number.
;When this value is *not* the standard mail server port number, Agent
;uses it instead of the asking the winsock driver for the port number
;to use.

;=====================================================================
[Online]
AutoDisconnect=1
;Disconnect from news server after <NoActivityTimeout> seconds of
;inactivity.  Zero means never disconnect.

NoActivityTimeout=300
;Period of no activity after which the program should disconnect
;from the NNTP server (seconds).

MailAutoDisconnect=1
;Disconnect from mail server after <MailNoActivityTimeout> seconds of
;inactivity.  Zero means never disconnect.

MailNoActivityTimeout=5
;Period of no SMTP activity after which the program should disconnect
;from the SMTP server (seconds).

SendKeepAliveMsgs=1
;Send "keep alive" messages to the news server.
;This keeps the dial-up connection alive.

KeepAlivePeriod=60
;How often, in seconds, to send a keep alive message during periods of
;inactivity.

XHdrOnly=1
;When non-zero, use XHDR commands to request article header information
;from the news server, rather than XOVER.  Some servers do not support
;the newer XOVER command, which is faster than XHDR.  The program
;automatically detects whether the server recognizes XOVER and falls
;back to XHDR if it doesn't.  But, you can also use this option to
;force it to always use XHDR.

EnablePriorityTask=1
;When non-zero, enable priority tasks for retrieving article bodies.
;This allows the program to open two channels to the news server,
;with one reserved as a priority channel for retrieving articles.



AutoView=0
;What to do when you double-click on an article without a body
; 0 Retrieve the article's body
; 1 Mark the article for later retrieval
; 2 Retrieve the body if online, mark for retrieval if offline
; 3 Do nothing

RetryConnectAttempts=0
;How many times to retry connecting to the server after getting
;any of the following errors:

- Connection refused (winsock error 10061)
- Operation timed out (winsock error 10060)
- 400 Service not available

;If the parameter is zero, Agent reports an error after the first
;attempt.

RetryConnectPause=30
;How long to wait, in seconds, between connection attempts when
;retrying.

RetryConnectCloseWinsock=0
;When non-zero, Agent closes winsock after each connection failure and
;reloads it before retrying.  If you are using a winsock dialer, this
;causes the dialer to hang up the modem between connection attempts.

UseGetHostName=0
;By default, Agent uses winsock function WSAAsyncGetHostByAddr() to
;obtain the name of the PC itself, for use when logging into SMTP
;servers.   Setting this option to non-zero causes Agent to use
;function gethostname() instead.  This option can be used as a
;workaround for winsock drivers that do not support
;WSAAsyncGetHostByAddr().

;=====================================================================
[Timing]
GetHostByNameTimeout=30
;Timeout period for looking up the host's name (seconds)

ConnectTimeout=10
;Timeout period for connecting to host (seconds)

ResponseTimeout=120
;Timeout period for waiting for a response from the host (seconds)

SendTimeout=60
;Timeout period for sending a command to the server (seconds).
;This is the maximum time the program will wait during a blocked
;transmission, not the total time allowed to send a message.

PostTimeout=60
;Timeout period for posting an article or email message (seconds).
;This is the maximum time the program will wait during a blocked
;transmission, not the total time allowed to send a message.

SplashTime=5
;Minimum time to display the splash screen (seconds)

PostResponseTimeout=360
;How long, in seconds, Agent will wait for an acknowledgment from the
;server after posting an article or email message.



;=====================================================================
[TimeZone]
MinutesFromGMT=-480
;The local timezone, in minutes from GMT.
;If ObserverDST is true, this should be the offset for standard time.

ObserveDST=1
;Automatically adjust the timezone offset to account for DST
;between April and October.

AssumeLocal=1
;If a downloaded article does not specify a timezone in its Date field,
;assume local time.  When this option is not set, Agent assumes GMT.

TimeZoneName=5
;A number that uniquely identifies the timezone name as selected on
;the Preferences | System Profile dialog box, used to identify the
;particular name selected for zones with multiple choices.

;=====================================================================
[Message] 
UseFixedFont=1
;Use the fixed-pitch font for outgoing messages

WordWrap=1
;Word wrap outgoing messages in the display window

IncludeOriginalText=1
;Automatically include the text of the original article when creating
;a follow-up article or email reply.

QuotePrefix="> "
;String used to quote text from the original article when creating
;a follow-up article or email reply.

FollowupString=%from% wrote:\n
;The string used to generate the first line(s) of a follow-up article.
;This value should be defined directly from Agent.  For more
;information, see Composing an Introduction String.
;If the string is blank, no first line is generated.
;
;Text enclosed in %...% are the names of fields from the original
;article.  Two %% represent a single % literal.
;
;In addition to the standard article fields, the program supports these
;special fields:
; %Full-Name% Full name of author
;
;You may also use the following escape sequences:
; \n newline
; \t tab
; \\ the backslash character itself

MailReplyString=On %date%, you wrote:\n
;The string used to generate the first line(s) of an email reply.
;If the string is blank, no first line is generated.
;Uses the same formatting commands as FollowupString.

LineLength=70
;The maximum line length for outgoing messages.
;The program word-wraps longer lines.



;Setting this to zero disables word-wrap in outgoing messages.

SaveSentMessages=1
;Save messages that have been successfully posted in the outbox.

SendTagLine=0
;When non-zero, the Free Agent advertisement tag line is included at
;the bottom of messages.

GMTDates=1
;When non-zero, post all articles and emails in GMT format as opposed
;to your local timezone.

CurrentGroupOnly=1
;This option controls which newsgroups are included by default for
;follow-up posts.  If the referenced article includes a Followup-To
;field, Agent always lists the groups from that field, independent of
;this option.  If the referenced article does not contain a Followup-To
;field, and this option is set, Agent includes just the name of the
;group that was selected when the follow-up message was created.  If
;this option is not set (the default), Agent includes all groups listed
;in the referenced article's Newsgroups field.

ValidateAddresses=1
;When non-zero, Agent tries to validate all email address fields (To:,
;Cc:, Bcc:, From:, Reply-to:, and Sender:) in messages that you send. 
;Set this value to zero if you need to enter non-standard addresses.

ShowAllFields=0
;When non-zero, Agent allows editing of the Control and Approved
;message fields.

;=====================================================================
[Directories]
Attachments=C:\AGENT\, *.txt, 0
;Default directory and file type for saving and sending attachments.
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in the dialog box.

Files=C:\AGENT\, *.txt, 1
;Default directory and file type for importing and exporting text files
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in the dialog box.

Signatures=C:\AGENT\, *.txt, 1
;Default directory and file type for signature files
;The third parameter is the listbox index of the file-type filter
;(e.g.,"*.TXT") that was last selected in the dialog box.

Home=
;The directory where Agent’s database files and custom dictionaries are
;stored.  If this parameter’s value is blank (the default), Agent looks
;for these files in the directory containing AGENT.INI.  Note: Changing
;this setting does not move your files.  Use File Manager to move all
;the files (*.IDX, *.DAT, and CUST*.TLX) to the new location and then
;restart Agent for this change to take effect.

Shared=C:\AGENT
;The directory where Agent’s help file and master dictionaries are
;stored.

;=====================================================================



[Confirm]
DeleteGroup=1
;Confirm group deletions

StopTasks=1
;Confirm actions that would cancel active online tasks

DeleteArticle=1
;Confirm article deletions

DeleteOpenMessage=1
;Confirm closing message composition window if the user has modified
;the message

DeleteOutboxMessage=1
;Confirm message deletions in the outbox

CloseWithTasks=1
;Confirm program close when tasks are running

DefaultAction=0
;Default key in confirmation dialogs, 0=NO, 1=YES

MarkAllRead=1
;Confirm the Mark All Articles Unread and Mark All Articles Read
;commands.

;=====================================================================
[Colors]
BrowserNormalColor=0,0,0
;Color for normal articles
;<red>,<green>,<blue>

BrowserUnreadColor=128,0,0
;Color for unread articles.
;<red>,<green>,<blue>

BrowserSelectedUnreadColor=255,255,0
;Color for unread articles that are selected (highlighted).
;Normally, this should be the inverse of the Control Panel’s highlight
;color.
;<red>,<green>,<blue>

ArticleNormalColor=0,0,0
;The color for normal text in articles.

ArticleQuotedColor=0,0,255
;The color for quoted text in articles.
;A line is quoted if it begins with one of the QuotedTextMarkers.

;=====================================================================
[Attachment]
PartitionMode=1
;Controls how attachment messages are partitioned:
; 0 = Partition into messages (AttachmentPartitionSize controls size)
; 1 = Do not partition (send as a single message)

PartitionLines=900
;When attachment messages are partitioned, the maximum number of lines
;of data to send per message.  Each line contains 45 bytes of data,



;and consists of 63 characters.

TextMode=0
;Controls if and how text is sent with attachments
; 0 Send text as separate preface message
; 1 Include text at beginning of first partition message
; 2 Send no text

FileMode=644
;UNIX file mode for attachment files.  This is a string.
;This is the mode that is included at the top of the uuencoded file.

;=====================================================================
[Print]
LeftMargin=75
TopMargin=75
RightMargin=75
BottomMargin=75
;Margins for printing, in 1/100 inch increments.

Fields=1
;Header fields to include in printed messages
; 0 No fields
; 1 Subject, author, and date only
; 2 All fields

PageBreaks=0
;Where to put page breaks
; 0 None
; 1 Between articles
; 2 Between threads

Font=Times New Roman, 100, 0,0, 0,0,0
;Printer font

;=====================================================================
[Purging]
;The parameters in this section can be modified within Agent from the
;What to Purge tab on the Default Group Properties dialog box and the
;When to Purge tab on the Default Group Properties dialog box.

PurgeByNumber=1
;This option controls how Agent's purge operation determines whether
;an article is no longer available.
; 0 = Purge based on article range reported by the server.
; 1 = Always download headers and purge based on those.

PurgeOnNewHeaders=1
;Purge articles when getting new headers.

PurgeOnExit=1
;Purge articles when exiting Agent.

ConfirmPurgeOnExit=1
;Prompt for confirmation before doing a purge on exit.

CompressOnPurge=0
;When non-zero, selecting a Purge Articles option from the Group menu
;also compacts the databases being purged.  Note: A database is
;compacted only when the percent of disk space saved is greater than
;the value of the CompressPercent parameter.



CompressOnExit=0
;When non-zero, Agent will compact all your databases when it closes. 
;Note: A database is compacted only when the percent of disk space
;saved is greater than the value entered in the “Compact only if
;wasted space at least...” field below.

CompressPercent=20
;Before compacting a database, Agent checks to see how much disk
;space would be saved by the compact operation.  This setting allows
;you to bypass the operation if only a small amount of disk space
;would be saved.  Enter the minimum amount of disk space savings, as a
;percentage of the total size of the database, that will cause Agent
;to perform an automatic compaction after either a manual purge
;and/or an automatic purge during exit.

ConfirmPurgeOnExit=1
;When this option is non-zero, Agent asks for confirmation before
;purging and/or compacting databases when you close the program. 
;When this option is zero, the Agent will purge and/or compact the
;databases without asking first.  Note: To purge or compact databases
;on exit, be sure to enable PurgeOnExit and/or CompressOnExit.

AlwaysPurgeUnavailable=1
;When this option is on (the default), and you have selected one of
;the "When the article is no longer available" purge options, Agent
;will always purge articles that are no longer available during get
;new headers, even if you have turned off the "Purge when retrieving
;new headers" option.  This parameter cannot be set within Agent.

;=====================================================================
[Spelling]
;This section is not available in Free Agent.

AlwaysSuggest=1
;When non-zero, the spell checker will automatically suggest possible
;replacement words.

CheckRepeatedWords=1
;When non-zero, the spell checker will stop when it finds the same word
;twice in a row.

IgnoreNumeric=1
;When non-zero, the spell checker will ignore words containing numbers.

IgnoreUpperCase=1
;When non-zero, the spell checker will ignore words composed of all
;uppercase letters. 

IgnoreQuotedLines=1
;When non-zero, the spell checker will ignore words which appear on
;lines beginning with a quote character (as defined by the Quoted Text
;setting on the Preferences dialog boxes’ Display tab).

;=====================================================================
[Languages]
;This section is not available in Free Agent.

;This section is not included in AGENT.INI by default.  You can add it
;if you want to customize the spell checker’s dictionaries, however.
;Each parameter in this section has the following format:
;<id>=<name>,<apostrophe-flag>,<custom>,<master1>[,...<masterN>]
;
;<id> is a three-letter language ID, which uses the same convention as



;WIN.INI.  Here are the current ids:
; enu English (American)
; eng English (International)
; frn French
; ger German
; itn Italian
; spn Spanish
;
;<name> is the name of the language as displayed in Agent.
;
;<apostrophe-flag> is a 0/1 flag indicating whether apostrophe should
;be considered a word separator.  When this flag is true (1), if a word
;containing embedded apostrophes is not found in any dictionary, Agent
;treats the apostrophe as a word separator and checks each sub-word
;individually.  Normally, this flag is set only for French, in which it
;is common to create new words by combining words with apostrophe.
;
;<custom> is the name of the custom dictionary.   By convention, this
;file is named CUST<id>.TLX.  If the filename has no path, Agent looks
;for the file in the Home directory.  If the file does not exist, Agent
;creates it.
;
;<master> is the name of one or more master dictionaries.  You can list
;up to 12 files.  When checking words, Agent searches the dictionaries
;in the order listed.  By convention, the common words file is named
;MAIN<id>.TLX and the compressed words file is named MAIN<id>.CLX.  If
;the filename has no path, Agent looks for the file in the shared
;directory.  If none of the master dictionaries for a given language
;exist, Agent assumes that the language is unavailable, and removes it
;from the list of available languages in the UI.

;=====================================================================
[Debugging]
ShowUID=0
;When non-zero, Agent shows the group UIDs in the Group Pane.  This
;number is the base filename for each group's IDX and DAT files.

VerboseLog=0
;When non-zero, include extra information in the log window, including
;a script of Agent's conversation with the news server, and task state
;machine transitions.

FileLog=0
;When non-zero, Agent writes log output to AGENT.LOG.  The contents of
;this file are erased at the start of each Agent session.

TraceLog=0
;When non-zero, send log output to the Windows debugging console, so
;that it appears in programs like DBWIN.

TraceHelp=0
;When non-zero, send a debugging statement to the Windows debugging
;console each time Agent sends a request for online help.

ShowArticleDetail=0
;When non-zero, show some detailed information about articles at the
;bottom of the article body pane.   In particular, this shows the
;article's number as reported by the news server.

ShowMemUsage=0
;When non-zero, show the total number of allocated blocks in the status
;bar.  This option is used to check for memory leaks.



EnableTrace=0
;When non-zero, enable debugging trace statements to be sent to the
;Windows debugging port.

WinsockLog=0
;When non-zero, all winsock calls are written to AGENT.LOG.

EnableMenu=0
;When non-zero, Agent displays the debugging menu options.  You can
;also toggle the display of the debug options by pressing Ctrl+Shift+D
;in Agent.

ShowBuild=0
;When non-zero, Agent displays the build number in the title bar and
;About dialog box.



Release Notes
This topic describes the features most recently added to Agent.    For a more comprehensive set of 
release notes, please check our Web pages (http://www.forteinc.com/forte/).

Version 1.00
Improved the Purging option to give you more control over which articles are purged.    Also, you can now 
purge groups manually, and automatically on program exit.    For details, see the Purging tab of the 
Properties for Selected Group dialog box.

Added an option to compact the databases.    To compact your databases, choose Compact Databases 
from the File menu.

Significantly improved download, threading, and purging performance.    Now, purging most groups should
only take a few seconds at most.

You can now send an email carbon copy (CC) when you post an article.    This is especially useful when 
you want to post a follow-up response and email the original author at the same time.    For more 
information, see Compose Article window.

Moved some commands from the File menu to a new Options menu and the Window menu.    Commands
that control program configuration are now on the Options menu.    Commands that open new windows 
are now on the Window menu.

Agent now allows you to edit all header fields (Distribution, Keywords, etc.) for messages you send.    For 
more information, see Compose Article window and Compose Email window.

You can now mark an article unread while you are viewing its body.

Selecting Watch Thread on an unread    article now skips to the next unread article.    You can disable this 
option with the Navigation tab of the Preferences dialog box..

You can now control whether or not Agent should validate email addresses in your messages.    For 
details, see the Message Posting tab of the Preferences dialog box.

You can now cancel a post after you send it.    To cancel a post, highlight the article in the Article pane and
choose Cancel Article from the Article menu.

Agent now accepts a command line parameter to specify the location of AGENT.INI.    E.g., agent 
<path>.    The optional <path> argument can be either the directory containing AGENT.INI or the name of
the INI file to use as AGENT.INI.
· If no <path> is specified, Agent looks for AGENT.INI in the current working directory.    If the file 

doesn't exist, Agent creates it.
· If <path> is a filename, Agent uses that file as AGENT.INI.    If the file doesn't exist, Agent creates it.
· If <path> is a directory, Agent looks for AGENT.INI in the specified directory.    If the file doesn't exist, 

Agent creates it.    Note: If the directory doesn't exist, Agent assumes that you are specifying a 
filename.    You can prevent this from happening by appending a \ to the end of the directory name to 
force Agent to always treat it as a directory.      For example: c:\agent\.

Added support for Spry’s winsock dialer.    This fixes problems using Agent with Internet in a Box and 
CompuServe.    You no longer have to manually start the Spry dialer prior to having Agent go online.

Agent is now less strict when searching for the articles composing a binary attachment.    It ignores case 
and leading/trailing whitespace when comparing the article subjects.

Added “Delete Body” to the Article menu.    Select this option to delete the selected article’s body but not 
its header.

Add drag-select support to highlight multiple groups or articles with the mouse.    Just click and drag the 
mouse over the groups or articles.

Agent now starts a new thread when a follow-up article has a different subject than the original.    You can 
control this behavior with the Navigation tab on the Preferences dialog box.



Agent's dialog boxes now have the correct 3D look when running in Windows 95.

After unsubscribing to a group or leaving a group you just sampled, Agent now asks if you want to keep 
the group’s articles.    If you say “No,” it will immediately delete articles in the group.    This feature helps 
you delete unwanted database files from your disk.

Agent now includes all newsgroups from the original article when you post a follow-up to a cross-posted 
article.    This option is controlled by an AGENT.INI parameter: 

[Message]
CurrentGroupOnly=0

Added a confirmation message when you mark all the articles in group as read or unread.    You can turn 
this message off from the Confirmations tab of the Preferences dialog box.

Agent can now retry refused connections that can occur when the news server is very busy.    For details, 
see the Online Operation tab of the Preferences dialog box.

Added context menus to the Composition and Outbox windows.    Context menus are activated by clicking
the right mouse button.

Add a preference option for selecting which mouse button selects items from the context menu.    See the 
Navigation tab of the Preferences dialog box for details.

Skipping to the next unread article from the Group pane now moves the focus to the Article pane for the 
next group with an unread article and selects that article.    You can disable this behavior by unchecking 
the “Skipping to next unread article jumps...” box on the Navigation tab of the Preferences dialog box.

Agent now adds a leading zero when posting multi-part attachments.    E.g., [04/15].

When an article does not contain a timezone, Agent now assumes local time.    It used to assume GMT.    
This feature is controllable via an AGENT.INI parameter:

[TimeZone]
AssumeLocal=1

Choosing Get Selected Article Bodies when a collapsed thread is selected now retrieves the bodies of all 
the articles in the thread.

You can now specify a location for your database files (*.IDX and *.DAT).    To keep your database files in 
a directory other than Agent’s normal working directory, edit the Home parameter in the [Directories] 
section of AGENT.INI.

Ctrl+A now works in the Outbox window.

Added an option to AGENT.INI to override the Port numbers used for the NNTP and SMTP servers.    
See AGENT.INI for details.

Agent now deletes the Outbox files when all the messages in the outbox are deleted.

Agent now strips EOF characters from signatures when posting.

The various debugging parameters are now documented in the AGENT.INI help topic.

Agent now purges all but the most recent article in an ignored thread.

Agent now detects when the news server renumbered the articles in a group.    When this occurs. Agent 
adjusts the high article numbers accordingly and retrieves all new articles.








